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Guide to Installing an Atlassian Integrated Suite
We have put together a guide (see below) to integrating a suite of Atlassian applications. The guide consists of detailed step-by-step
instructions for setting up a specific configuration. There are also links to the installation and configuration guides for each component.
Setting up the integrated suite will give you awesome results, but we know that the setup procedure can be long and difficult. So we invite
you to join the Atlassian Dragon Quest.
Starting from scratch? If you do not have any Atlassian applications installed, please start at Here Be Dragons.
Got JIRA? If you are already using JIRA, please start at Dragon Slayers with JIRA Already Installed.

Here Be Dragons

Beware, all ye who enter, for here be dragons! This is the starting point for the Atlassian Dragon Quest.
By the time you reach the end of this set of instructions, you will have an awesome Atlassian integrated development suite (details below).
There's a good chance that the Atlassian Integration Dragon will scorch the clothes off your back somewhere along the way, so we'll also
send you a free, limited-edition Atlassian DragonSlayer T-shirt when you have completed all the steps.
Got JIRA? If you are already using JIRA, please start at Dragon Slayers with JIRA Already Installed.

Getting help
If you run into problems at any stage of the integration procedure, please raise a support ticket for the product you're stuck
on. Please don't try to battle on alone. Instead, ask for help immediately. You can also see answers from the community, or
search the forum of past dragon slayers.

Rushing into the Dragon's Lair
Don your armour and alert your serfs
If you like, you can tweet your status.

Follow yon brave dragon slayers
On the Atlassian Dragons Twitter stream.

Please read the introduction below.
Now you're ready to start stage 1. Meet the dragon if you dare!
Dragons Stage 1 - Install JIRA
Dragons Stage 2 - Set Up GreenHopper in JIRA
Dragons Stage 3 - Install Confluence
Dragons Stage 4 - Install FishEye and Crucible
Dragons Stage 5 - Get JIRA and FishEye Talking
Dragons Stage 6 - Get JIRA and Crucible Talking
Dragons Stage 7 - Install Bamboo
Dragons Stage 8 - Bamboo Gadgets and JIRA Victory
After Dragons

What's This All About?
We have put together these instructions for integrating a suite of Atlassian applications. Setting up the integrated suite will give you awesome
results, but we know that the setup procedure can be long and difficult.

2

Atlassian Integration Guide

Why would we ask you to undertake this exercise?
We're issuing a challenge to our boldest and most skilled customers and evaluators.
We'd like to learn from your experiences, so that we can improve the setup and integration procedures.
It's another excuse to give away some T-shirts.

The Wins

When you have completed the final stage, you will have set up these Atlassian applications and features to work with each other:
JIRA for bug tracking.
GreenHopper for agile project management.
Confluence, the enterprise wiki.
FishEye to open up your source repository.
Crucible for code reviews.
Bamboo for continuous integration.
Atlassian Gadgets.
If you slay the dragon, you win a free, limited-edition Atlassian DragonSlayer T-shirt too.
How Long Will It Take to Slay the Dragon?

We estimate that it will take 4 hours to complete all the stages.

Getting Kitted Out
Before you start, please note the points below.

Assumptions
This guide is written for a technical audience. You will need to install a database, install the Atlassian applications and adjust the
configuration files.
This guide assumes that you are starting from scratch, with no Atlassian applications installed or with only JIRA installed.
If you can start with a clean slate, with no Atlassian applications at all, please do continue with the integration procedure
described on this page and its child pages.
If you have JIRA but nothing else, please start at Dragon Slayers with JIRA Already Installed.
If you already have Confluence, FishEye, Crucible or Bamboo, please consult our support team.
This guide assumes that you will be using a specific database and specific versions of the applications and plugins, as described in
each stage of this guide. If you need to use other drivers or application versions, please consult our support team.
This guide assumes that you will set up all the applications on the same machine.

Hardware Requirements
We recommend the following:
2GB RAM.
No other applications running – just the operating system, JAVA, PostgreSQL and the Atlassian applications.
500MB disk space for application files.

Software Requirements
Program for extracting our downloaded archive files: Please check your unzip/unpack program before extracting any of the
Atlassian downloaded zip or archive files. Some unzip/unpack programs cause errors.
Linux or Unix users can use any unpack program.
Solaris users must use GNU Tar instead of Solaris Tar.
Windows users should use a third-party unzip program like 7Zip or Winzip. If you do not have one, please download and
install one before continuing:
7Zip — Recommended. If in doubt, download the '32-bit .exe' version
Winzip
Operating System: The instructions are for Windows, UNIX and Linux. We do not offer instructions for Mac OS X as it is not a
platform preferred by our customers. If you have specific questions about a platform that is not supported, please see answers from
the community, or search the forum of past dragon slayers.
Application server: By following our instructions, you will set up a standalone version of each Atlassian product, using the default
Tomcat or Jetty server provided with each application.
Database: By following our instructions, you will set up a PostgreSQL database server in stage 1 and use the database server in all
subsequent stages.
Source repository: For the purposes of this integration exercise, we have provided a read-only Bitbucket repository that you can
connect to your FishEye and Bamboo installations. We recommend this repository because:
We have committed a code change with a JIRA issue key in the commit message. This will allow you to see the JIRA and
FishEye integration immediately, without having to do your own commit.
The sample repository is small, so that FishEye's initial repository indexing process will be fast.
Build tool: For the Bamboo integration stages you will need a build tool, which Bamboo calls an executable. For this integration
exercise, we assume that you are using Maven 2. You can use any of the build tools supported by Bamboo, such as Maven 1,
Maven 2, Ant, PHPUnit and others. See the Bamboo documentation.
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If you wish to use Maven 2 and do not yet have it installed, we recommend the Atlassian Plugin SDK. The SDK includes Maven
2 and a correctly-configured Maven settings.xml file, as well as a number of shell scripts to speed up and simplify plugin
development. It also includes the Java Activation JAR (javax.activation:activation:jar) which you will need for a
successful Maven build. If you would like to download the Java Activation JAR separately instead, see the FAQ.
Java Development Kit: You will need Oracle JDK 1.6 or higher. Note that the JRE alone is not enough. Stage 1 of these
instructions will guide you through the installation process.

Other Notes
Virus checkers: If you have a virus checker running, there may be a delay in the availability of JAR files after you have placed a
required JAR into a directory, while the virus checker scans the file. This may happen with the PostgreSQL database driver files, for
example. If you receive an error saying that a driver or other such file is not available, wait a few minutes and try again.
Passwords: At several points in this integration procedure you will need to enter a password. The password will be used to secure
your data. The password you choose is up to you, but it is important you pick something that is hard to guess. Take a moment now
to think of a password. Here are some guidelines from AusCERT on choosing a good password. This will save you time later.
Rush into the dragon's lair.

Dragons Stage 1 - Install JIRA

Beware, all ye who enter, for here be dragons. You are embarking on stage 1 of the Atlassian Dragon Quest.
In this stage, you will install Java and a database (PostgreSQL) to hold the data for your Atlassian applications. Then you will install Atlassian
JIRA for bug tracking and issue management. JIRA will also act as a central user repository for all your Atlassian applications.
Time estimate: This stage will take approximately 60 minutes.
On this page:
Step 1. Install Java
Step 2. Install your PostgreSQL Database Server
Step 3. Create your JIRA Database in PostgreSQL
Step 4. Install JIRA
Step 5. Set Up JIRA
Step 6. Set up a Project and Create your JIRA Dashboard
Victory!

Step 1. Install Java
Requirements: Oracle JDK 1.6 or higher. Note that the JRE alone is not enough.
If you do not have the right version of the Java Development Kit (JDK) already installed, follow the steps below to get it.

1. Download the Oracle Java SE Development Kit (JDK).
Get the latest version of the JDK 1.6, at least version 6u23 or later.
If you are running 64-bit Windows, please ensure that you use 32-bit JDK and not the 'x64' JDK.
2. Follow the Oracle installation instructions.
3. Make sure you have a JAVA_HOME environment variable pointing to the root directory of the JDK. Some JDK installers
set this automatically.
Check by typing one of the following into a command window, depending on your operating system.
On Windows: echo %JAVA_HOME%
On Linux or UNIX: echo $JAVA_HOME
If the above command does not show you the path to your JDK, please refer to the Crowd instructions on
setting JAVA_HOME.
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Step 2. Install your PostgreSQL Database Server
Requirements: PostgreSQL version 8.4.x.

1. Download PostgreSQL – Get the latest 8.4.x. Note that Atlassian does not support PostgreSQL 9.x. For the simplest
installation, choose one of the one-click installers.
2. Install PostgreSQL. If you chose one of the PostgreSQL one-click installers, this is simple: Run the executable that you
downloaded and follow the prompts. Ensure that you choose UTF8 (unicode) encoding when selecting the locale. If
necessary, you can refer to the PostgreSQL installation instructions.
3. Enter a password for the super user ('postgres').
4. Accept the default port 5432.
5. Accept all the other default settings.

Step 3. Create your JIRA Database in PostgreSQL
Now you will create a database where the Atlassian JIRA application will store its data, and the user that JIRA will use to connect to the
database. We are assuming that you have already created your PostgreSQL database server in a previous step.
We are using pgAdmin III, the administration user interface supplied with PostgreSQL. If you used the one-click installer when installing
PostgreSQL, pgAdmin III will be already installed on your computer.

1. Start pgAdmin III.
2. Add a new login role called 'jirauser':
Right-click 'Login Roles' and select 'New Login Role'.
Enter the role 'Role name': jirauser.
Enter a 'Password' and enter it again to confirm it.
Click the 'Role privileges' tab.
Select 'Can create database objects'.
Select 'Can create roles'.
Click 'OK' to create the user.
3. Add a new database called 'jira':
Right-click 'Databases' and select 'New Database'.
Enter the database 'Name': jira.
Select the 'Owner': jirauser.
Click 'OK' to create the database.

Alternatively, If you are on UNIX and do not have pgAdmin III, you can use the command line interface instead. Assuming that you are
using the default installation directory of /opt/PostgreSQL/8.4/bin/, enter the following commands:

sudo -s -H -u postgres
# Create the JIRA user:
/opt/PostgreSQL/8.4/bin/createuser -S -d -r -P -E jirauser
# Create the JIRA database:
/opt/PostgreSQL/8.4/bin/createdb --owner jirauser --encoding utf8 jira
exit

Screenshot 1 (click to enlarge): JIRA database and user in PostgreSQL

Step 4. Install JIRA
Requirements: JIRA 4.4.
For Windows: (click to expand)
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1. Go to the Atlassian download centre.
2. Download the 'Standalone (Windows installer)' .exe file for JIRA 4.4.
Please use the JIRA version specified in this documentation. If the download centre shows a JIRA version
later than 4.4, click 'downloads archive' and get JIRA 4.4.
Why? We have tested the integration suite with this version. There is a chance that you will have problems
integrating the other applications if you use a different version.
3. Log in to your computer as a Windows administrator.
To install JIRA as a service, you must run the Windows installer using a Windows administrator account. While
you can run the Windows installer with a non-administrator account, your installation options will be limited.
4. Run the JIRA installer .exe file.
On Windows 7 or Vista, right-click the file name and click 'Run as administrator'.
5. If a Windows 7 or Vista 'User Account Control' dialog box asks you to allow the installation wizard to make
changes to your computer, specify 'Yes'.
6. Enter the following information as prompted by the installer:
Upgrading JIRA? Select 'Create a new JIRA installation'.
Destination directory: Tell JIRA where to put its installation directory containing the application files and
libraries. For example: C:\Program Files (x86)\Atlassian\JIRA.
Home directory: Tell JIRA where to put its home directory, the data directory containing configuration
files, attachments and more. For example: C:\Program Files (x86)\Atlassian\Application
Data\JIRA.
Start Menu Folder: Specify the menu item for JIRA that will appear in your Windows 'Start' menu.
TCP Ports: Use the default ports (HTTP 8080 and Control 8005).
Run as Service: Select 'Install JIRA as Service'.
7. When prompted, select 'Launch JIRA in browser' and click 'Finish' to close the installer. The installer will finish
installing JIRA, then it will start the JIRA server and open the JIRA Setup Wizard in your web browser. See below
for further instructions.

For UNIX or Linux: (click to expand)

1. Go to the Atlassian download centre.
2. Click the 'Linux' tab and download the JIRA 4.4 installer for your UNIX system.

3.

4.

5.

6.

Please use the JIRA version specified in this documentation. If the download centre shows a JIRA version
later than 4.4, click 'downloads archive' and get JIRA 4.4.
Why? We have tested the integration suite with this version. There is a chance that you will have problems
integrating the other applications if you use a different version.
If you are running 64-bit Linux, download the 'Standalone (Linux 64 Bit Installer)' file for JIRA 4.4 and
continue following the installation steps below.
If you are running 32-bit Linux, download the 'Standalone (Linux 32 Bit Installer)' file for JIRA 4.4 and
continue following the installation steps below.
If you are running some other flavour of UNIX, download the 'Standalone (TAR.GZ Archive)' file for JIRA
4.4 and follow the JIRA guide to installing from an archive then return to step 5 (Set Up JIRA) below.
Open a Linux console and change directory (cd) to the directory containing the .bin file.
If the .bin file is not executable after downloading it, make it executable. For example:
chmod a+x atlassian-jira-X.Y.bin
(where X.Y represents your version of JIRA)
Execute the .bin file with 'root' user privileges, to start the JIRA installer.
If you execute the installer with 'root' user privileges, the installer will create and run JIRA using a dedicated user
account. You can also execute the installer without 'root' user privileges, but your installation options will be
limited. To run JIRA as a service, you must execute the installer with 'root' user privileges.
Choose the following options as prompted by the installer:
Create a new JIRA installation.
Installation directory: This directory will contain the application files and libraries. For example:
/opt/atlassian/jira.
Default location for JIRA data: This is the data directory, also called the JIRA home directory, containing
configuration files, attachments and more. For example: /var/atlassian/application-data/jira.
TCP Ports: Use the default ports (HTTP 8080 and Control 8005).
Install JIRA as Service: Choose Yes.
The installer will finish installing JIRA, then it will start the JIRA server and open the JIRA Setup Wizard in your
web browser. See below for further instructions.

Full details are in the JIRA installation guide.
Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 5. Set Up JIRA
Now you can run JIRA's Setup Wizard and then enable some JIRA features that are required for the later stages in this integration
procedure.
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1. To access JIRA, go to your web browser and type this address: http://localhost:8080.
2. The JIRA Setup Wizard will start up, to guide you through the process of setting up your JIRA server and creating an
administration user. Detailed instructions are in the JIRA documentation. Below are the things you need to know for
our Dragon Quest.
3. Enter the following information to configure the database connection:
Database connection: External
Database type: PostgreSQL
Hostname – Enter the name or IP address of the server where you installed your PostgreSQL database:
localhost
Port – Enter the default port that you set up for PostgreSQL: 5432
Database – This is the name of the database that you created in step 3 above: jira
Username – This is the user you created in step 3 above: jirauser
Password – Enter the password you chose in step 3 above.
Schema – Leave this at the default setting: public
4. Click the 'Test Connection' button to test the connection settings.
5. When you have a working connection, click 'Next'.
6. Enter the following application properties:
Application Title – Accept the default application title: My company JIRA
Mode – Accept the default mode.
Base URL – Enter the full website address at which JIRA is running, not just 'localhost'. For example, if your
computer name is 'coopers' then the base URL should be: http://coopers:8080. Or specify a website
address, such as http://www.foobar.com:8080.
License Key-- If you do not already have a JIRA license, follow the prompts on the setup wizard screen to get
an evaluation license key.
Make sure you have a JIRA 4 license. Existing 3.x licenses will not work.
7. Click 'Next'.
8. Specify the administrator account. This will be your JIRA super user:
Username: charlie
Password – Enter a password for the administrator account and enter it again to confirm it.
Full name: Charlie of Atlassian
Email – We recommend that you give your own email address here.
9. Click 'Next'.
10. Email notifications – For the purposes of the Atlassian Dragon Quest, we recommend that you leave email notifications
disabled. This is the default setting.
11. Click 'Finish'.
12. Log in to JIRA with username charlie and perform the following configuration steps:
a. Allow unassigned issues and check that the remote API is enabled:
Click 'Administration' in the top navigation bar.
Click 'System' > 'General Configuration' in the top menu.
Enter your password as prompted, to confirm that you want administrator access. (Note that the
Atlassian applications will request this confirmation at various steps in the process. This guide will not
mention this step again.)
Click 'Edit Configuration'.
Select the 'ON' radio button next to 'Allow unassigned issues'.
Check that the 'ON' radio button is selected next to 'Accept remote API calls'. It is on by default.
Click 'Update'.
b. Add the groups that you will need later for Confluence and Bamboo:
Click 'Users' > 'Groups' in the top menu.
In the 'Add Group' section, enter a group name of 'confluence-users' and click 'Add Group".
Add the following two groups as well:
confluence-administrators
bamboo-admin
c. Make Charlie of Atlassian a user and administrator in Confluence and Bamboo by adding him to the relevant
groups:
Click 'Bulk Edit Group Members'.
In the left-hand box, select the three groups:
bamboo-admin
confluence-administrators
confluence-users
In the right-hand box under 'Add members to selected group(s)', enter the username 'charlie'.
Click 'Join'. Charlie's name will appear in the middle box as a group member of the selected groups.

Screenshot 2: The JIRA Dashboard when you first log in

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
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dragon slayers.
Victory? Please continue.

Step 6. Set up a Project and Create your JIRA Dashboard
In this step you will create some data in JIRA, including a project and an issue, for use in the subsequent stages of this integration procedure.
Then you will create your own JIRA dashboard with a couple of gadgets.

1. Create a project in JIRA:
Click 'Projects' > 'Projects' in the top menu.
Hint: Try JIRA's quick search instead of the menus. Press g g on your keyboard then start typing 'projects'
into the 'Administration Search' box. If you like, you can use the quick search from this point onwards.
Click 'Add Project'.
Enter the following information:
Name: Dragons.
Key: DRA.
Click 'Add'.
2. Add two versions (1.0 and 2.0):
Click 'Versions' in the left-hand panel of the 'Dragons' project screen.
Enter the following information then click 'Add':
Name: 1.0.
Description: Version 1.0.
Add Version 2.0 as well.
3. Add an issue to your project:
Click 'Exit Administration' at the top of the administration screen
The dashboard will appear. Click 'Create Issue' at the top of the dashboard.
Select the following options then click 'Create':
Project: Dragons.
Issue Type: Bug.
Enter the following information about your new issue then click 'Create':
Summary: Dragon slayer's equipment is defective
Affects Version/s: 1.0.
Assignee: Charlie of Atlassian – Click 'Assign To Me'.
Description: There's a hole in the dragon slayer's water bucket.
Original Estimate: 1d.
You now have an issue with a key of 'DRA-1'.
4. Create a new dashboard for all your dragon-related tasks, issues and general fire fighting:
Click 'Dashboards' at top left of your JIRA screen.
Click 'Tools' > 'Create Dashboard'.
The 'Create New Dashboard' screen will appear. Enter the following information:
Name: Dragon Development Dashboard.
Description: A dashboard for dragon slayers, fire fighters and like-minded
brave souls.
Leave the other fields at their default values and click the 'Add' button at the bottom of the 'Create New
Dashboard' screen (not the one next to 'Add Shares').
5. You now have a new, empty dashboard. Add the 'Projects' gadget to the dashboard:
Click 'Add Gadget'.
The 'Gadget Directory' will appear, showing a list of the available gadgets for your JIRA dashboard. Enter
'projects' into the search box at top right of the gadget directory.
The list of gadgets will change, to show only the gadgets that match your search term. Find the ' Projects'
gadget and click 'Add it Now'. The gadget will be highlighted for a short time and the button's wording will
change to 'Adding', while JIRA adds the gadget to the dashboard.
6. Find and add the 'Assigned To Me' gadget in the same way.
7. Click 'Finished' to go back to your dashboard.
8. Drag the 'Assigned to Me' gadget to the top right of your dashboard:
Move your mouse pointer over the gadget's blue title bar.
The cursor icon will change to a four-pointed arrow
(or a hand). Click the gadget title bar with the left
mouse button then drag the gadget to the right. Drop it in the space labelled 'Drag your gadget here.'
9. Configure the 'Assigned to Me' gadget to point to your 'Dragons' project:
Leave the default values as configured for 'Number of Results' and 'Columns to display'.
Click the dropdown arrow next to 'Refresh Interval' and select 'Every 15 Minutes'.
Click 'Save'.
10. Configure the 'Projects' gadget:
Leave the default values as configured for 'Projects', 'View' and 'Number of Columns'.
Click the dropdown arrow next to 'Refresh Interval' and select 'Every 15 Minutes'.
Click 'Save'.

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Victory!
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You can now see your project dashboard with 2 gadgets on it! The 'Projects' gadget shows the project lead Charlie of Atlassian. The
'Assigned to Me' gadget shows the single DRA-1 issue assigned to Charlie.
Screenshot 3 (click to enlarge): JIRA dashboard with 2 gadgets

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Don your Belt and Boots, and Move to the Next Stage

Tweet? Tweet.
Go to Dragons Stage 2 - Install GreenHopper into JIRA.

Dragons Stage 2 - Set Up GreenHopper in JIRA

Beware of fiends and dragons on the gargoyled eaves. You are embarking on stage 2 of the Atlassian Dragon Quest.
In this stage, you will set up GreenHopper in JIRA, for agile project management. The GreenHopper plugin is shipped with JIRA. All you
need to do is enable it.
Time estimate: This stage will take approximately 15 minutes.
On this page:
Step 1. Enable the GreenHopper Plugin in JIRA
Step 2. Add Another JIRA Issue and a Sprint
Step 3. Use the Scrum Template for your Project and Add a Story
Step 4. Add the GreenHopper Gadget to your JIRA Dashboard
Victory!

Step 1. Enable the GreenHopper Plugin in JIRA
In this step you will install the GreenHopper plugin into JIRA.
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1.
2.
3.
4.
5.
6.
7.

Go to your JIRA URL in your browser, e.g. http://www.foobar.com:8080.
Click 'Administration', then click 'Plugins' > 'Plugins' in the top menu.
The plugin management screen will appear. Click the 'Manage Existing' tab.
Click 'Show System Plugins'.
Find the GreenHopper plugin in the list of plugins and click the 'GreenHopper' plugin name.
The plugin details will appear. Click 'Enable'.
Set up your GreenHopper license key:
Click 'Plugins' > 'GreenHopper' in the top menu. (Refresh the screen if the option does not appear
immediately.)
The 'GreenHopper License Information' screen will appear.
If you do not already have a GreenHopper license, open a new browser window and go to My Atlassian, then
follow the prompts to get a 'GreenHopper for JIRA 4: Evaluation' license key.
Paste your GreenHopper license key into the 'GreenHopper License' textbox on your JIRA screen.
Click 'Add'.
8. Click 'Exit Administration', then click 'Agile'.
You will see the Dragons planning board, supplied by GreenHopper in JIRA.
(If you do not see the planning board, click the down arrow next to 'Agile' and select ' Planning Board'.)

Screenshot 1 (click to enlarge): The GreenHopper planning board in JIRA

There's more about getting started with GreenHopper in the GreenHopper documentation.
Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 2. Add Another JIRA Issue and a Sprint
Now that you have GreenHopper you can choose to update your issues via the GreenHopper tabs or via the standard JIRA interface. For this
exercise you will do your updates via GreenHopper.
First you will create two 'sprints', also known as 'milestones'. A sprint is a short period of time, two weeks for example, in which your
developers focus on a particular set of tasks. Then you will create a new issue and include it in one of the sprints. Finally you will add your
existing issue to the same sprint.
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1. Click the 'Add' button above the version cards, near the top right of the planning board.
2. The 'Add Version' screen will appear. Add a sprint with the following information:
Version Name: 2.0.S1
Description: Version 2.0 Sprint 1
Leave the default values for the other fields.
Click 'Create and Close'.
3. Follow the above steps to add another sprint with the following information:
Version Name: 2.0.S2
Description: Version 2.0 Sprint 2
4. Your two new sprints will appear as boxes on the right of the planning board, underneath the '2.0' box. Now you need
to include the two sprints into the existing version 2.0. Click the sprint box for sprint '2.0.S1'.
5. Within the sprint box click the gear icon (top right) and select 'Toggle visibility', or double click the sprint title bar, to
expand the box.
6. The 'Parent' is currently set to 'none'. Click 'Parent'.
7. A dropdown list will appear. Select '2.0'.
8. The '2.0.S1' sprint will become part of version 2.0 – the gap between the boxes will disappear and a small downward
and rightward-pointing arrow will appear next to the heading '2.0.S1'.
9. Edit the 'Parent' for sprint '2.0.S2' in the same way.
10. You now have two sprints within version 2.0. Next you will add a new issue, also known as a card. Click 'New Card' on
the planning board. Enter the following values:
Card type: Bug
Priority: Blocker
Summary: Exploding flame extinguishers
Version: Unscheduled
Component: Unknown
Original estimate: 2d
Assignee: charlie
11. Click 'Create and Close', to create the issue.
12. You will see your planning board again. It currently shows no cards. Click the version number dropdown near the top
left of the screen (currently showing '2.0.s2') and select 'Unscheduled' to see all the cards.
13. Click the card for issue DRA-1, drag the card to the right and drop it onto the box for sprint '2.0.S1'.
14. Drag DRA-2 to sprint '2.0.S1' as well.
15. Your planning board will now be empty, because it is currently showing cards for version 'Unscheduled'. Click the
version number '2.0.S1' at the top of the version 2.0.S1 box on the right. You should now see your two cards DRA-1
and DRA-2.
16. Click the version number '2.0' at the top of the version 2.0 box on the right. Notice the following points:
The value in the version number dropdown box at the top of the planning board also changes to '2.0'.
Your two issue cards are included in version 2.0 as well as in sprint 2.0.S1.
You can double click the title bar of each version box, to minimise or expand the box.
17. Mark one of your issues as complete:
Click the down arrow next to 'Planning Board' and select 'Task Board'.
Your task board will appear, with your two issue cards in the 'To Do' column on the left. Click the card for '
DRA-2', drag it to the right and drop it in the 'Done' column.
The 'Transitioning Issue' screen will appear. Select 'Close Issue' and click 'Update'.
The 'Close Issue' screen will appear. Click 'Close Issue'.

Screenshot 2 (click to enlarge): The GreenHopper task board for version 2.0

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 3. Use the Scrum Template for your Project and Add a Story
GreenHopper includes a project template for projects using the Scrum methodology. The template adds custom fields, such as ranking fields
and story points, to your project. It also allows you to create stories, epics and technical tasks. In this step you will apply the Scrum template
to your project and create a story.
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1.
2.
3.
4.
5.

Go back to your planning board, then click 'Tools' > 'Configuration'.
The project configuration screen will appear. Click the 'General' tab.
Select 'Scrum' from the 'Project Template' dropdown menu.
Click 'Change template' on the confirmation window.
Next you will create a new story. Go back to your planning board and click 'New Card'. Enter the following values:
Card type: Story
Priority: Major
Summary: As a dragon slayer I would like to wield an extremely big sword.
Version: 2.0
Component: Unknown
Business Value: 10
Assignee: charlie
Story Points: 10
6. Click 'Create and Close'. You will see your planning board again. If your new story does not appear on the board,
click the version number '2.0' at the top of the version 2.0 box on the right so that the board shows all cards for version
2.0.

Screenshot 3 (click to enlarge): The GreenHopper planning board with story

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 4. Add the GreenHopper Gadget to your JIRA Dashboard
Now you will add the GreenHopper 'Agile' gadget to your Dragon Development Dashboard.

1. Click 'Dashboards' at top left of your JIRA screen.
2. Your 'Dragon Development Dashboard' will appear. Click 'Add Gadget'.
3. The 'Gadget Directory' will appear, showing a list of the available gadgets for your JIRA dashboard. Enter 'agile' into
the search box at top right of the gadget directory screen.
4. The list of gadgets will change, to show only the gadgets that match your search term. Find the 'GreenHopper Agile
Gadget' and click 'Add it Now'. The gadget will be highlighted for a short time and the button's wording will change to
'Adding', while JIRA adds the gadget to the dashboard.
5. Click 'Finished' to go back to your dashboard.
6. Configure the 'GreenHopper Agile Gadget':
Start typing 'Dragons' in the 'Project or Saved Filter' box and select 'Dragons (DRA)' from the dropdown list
that appears.
Leave the default value for 'Display chart values' and 'Display chart legend'.
Click the dropdown arrow next to 'Refresh Interval' and select 'Every 15 Minutes'.
Click 'Save'.
Click the version dropdown arrow next to 'Unscheduled' and select '2.0'.
The gadget will display the 'Hours' burndown chart. Click the 'Issues' tab to see the issues burndown chart.
(The burndown charts will become more interesting when you have more issues in your project.)
7. Choose a different colour for your 'GreenHopper Agile Gadget' gadget:
Move your cursor pointer over the gadget and click the downward-pointing arrow at top right of the gadget
frame.
Select the green square in the row of colours.

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Victory!
Your JIRA dashboard now has 3 gadgets:
The GreenHopper 'Agile Gadget'
The 'Assigned to Me' gadget
The 'Projects' gadget
Screenshot 4 (click to enlarge): JIRA dashboard with 3 gadgets
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Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Don your Chain Mail and Move to the Next Stage

Tweet? Tweet.
Go to Dragons Stage 3 - Install Confluence.

Dragons Stage 3 - Install Confluence

Beware of low-flying worms. You are embarking on stage 3 of the Atlassian Dragon Quest.
In this stage, you will install Atlassian Confluence, the enterprise wiki. You will configure JIRA to manage your Confluence users, and get
your JIRA and Confluence sites talking to each other. Then you will create a wiki space, add a dynamic display of JIRA issues to a wiki page,
and add a Confluence activity stream to your JIRA dashboard.
Time estimate: This stage will take approximately 60 minutes.
On this page:
Step 1. Create your Confluence Database in PostgreSQL
Step 2. Install Confluence
Step 3. Set Up Confluence
Step 4. Hook Confluence up to JIRA for User Management
Step 5. Get JIRA and Confluence Talking
Step 6. Create a Wiki Space
Step 7. Add Some JIRA Issues to your Confluence Page
Step 8. Add a Confluence Gadget to JIRA
Victory!

Step 1. Create your Confluence Database in PostgreSQL
Now you will create a database where the Atlassian Confluence application will store its data, and the user that Confluence will use to
connect to the database. We are assuming that you have already created your PostgreSQL database server in Dragons Stage 1.
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We are using pgAdmin III, the administration user interface supplied with PostgreSQL. If you used the one-click installer in Dragons
Stage 1, pgAdmin III will be already installed on your computer.

1. Start pgAdmin III.
2. Add a new login role called 'confuser':
Right-click 'Login Roles' and select 'New Login Role'.
Enter the 'Role name': confuser
Enter a 'Password' and enter it again to confirm it.
Click the 'Role privileges' tab.
Select 'Can create database objects'.
Select 'Can create roles'.
Click 'OK' to create the user.
3. Add a new database called 'confluence':
Right-click 'Databases' and select 'New Database'.
Enter the database 'Name': confluence
Select the 'Owner': confuser
Click 'OK' to create the database.

Alternatively, If you are on UNIX and do not have pgAdmin III, you can use the command line interface instead. Assuming that you are
using the default installation directory of /opt/PostgreSQL/8.3/bin/, enter the following commands:

sudo -s -H -u postgres
# Create the Confluence user:
/opt/PostgreSQL/8.4/bin/createuser -S -d -r -P -E confuser
# Create the Confluence database:
/opt/PostgreSQL/8.4/bin/createdb --owner confuser --encoding utf8 confluence
exit

Screenshot 1 (click to enlarge): Confluence database and user in PostgreSQL

Step 2. Install Confluence
Requirements: Confluence 3.5.7.
For Windows: (click to expand)
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1. Go to the Atlassian download centre.
2. Download the 'Standalone (ZIP Archive)' file for Confluence 3.5.7.
Do not use the 'Windows Installer' for this integration exercise, because the workflow for configuring an
external database is simpler when installing from the zip archive. If you cannot see the 'Zip Archive', click the '
Show all' link above the download buttons to see all the download file types.
Please use the Confluence version specified in this documentation. If the download centre shows a
Confluence version later than 3.5.7, click 'downloads archive' and get Confluence 3.5.7.
Why? We have tested the integration suite with this version. There is a chance that you will have problems
integrating the other applications if you use a different version.
3. Unpack the zip archive into a directory of your choice, avoiding spaces in the directory name.
4. Tell Confluence where to put its Confluence Home directory:
Edit the properties file at {
CONFLUENCE_INSTALL}\confluence\WEB-INF\classes\confluence-init.properties.
Remove the hash sign (#) in front of the following line, and enter the directory name:
# confluence.home=c:/confluence/data
For example:
confluence.home=c:/data/confluence-home
(Note the forward slashes.)
Save the file.
5. Because Confluence will be running on the same machine as JIRA (already installed), you need to ensure that the
ports and URL paths are different for Confluence and JIRA. By default, both applications use port 8080. Change
the default Confluence port and path as follows:
Edit the configuration file at {CONFLUENCE_INSTALL}\conf\server.xml.
Change the value of the port attribute in the Connector element to 8090.
<Connector className="org.apache.coyote.tomcat4.CoyoteConnector"
port="8090" minProcessors="5"
maxProcessors="75"
enableLookups="false" redirectPort="8443"
acceptCount="10" debug="0" connectionTimeout="20000"
useURIValidationHack="false" URIEncoding="UTF-8"/>

Change the value of the path attribute in the Context element to /confluence:
<Context path="/confluence" docBase="../confluence" debug="0"
reloadable="false" useHttpOnly="true">

Save the file.
6. Start your Confluence server by running {CONFLUENCE_INSTALL}\bin\startup.bat.

For UNIX or Linux: (click to expand)

15

Atlassian Integration Guide

1. Go to the Atlassian download centre.
2. Click the 'Linux' tab and download the 'Standalone (TAR.GZ Archive)' file for Confluence 3.5.7.
Please use the Confluence version specified in this documentation. If the download centre shows a
Confluence version later than 3.5.7, click 'downloads archive' and get Confluence 3.5.7.
Why? We have tested the integration suite with this version. There is a chance that you will have problems
integrating the other applications if you use a different version.
3. Unpack the tar.gz archive into a directory of your choice, avoiding spaces in the directory name.
4. Tell Confluence where to put its Confluence Home directory:
Edit the properties file at {
CONFLUENCE_INSTALL}/confluence/WEB-INF/classes/confluence-init.properties.
Remove the hash sign (#) in front of the following line, and enter the directory name:
# confluence.home=c:/confluence/data
For example:
confluence.home=/var/confluence-home
Save the file.
5. Because Confluence will be running on the same machine as JIRA (already installed), you need to ensure that the
ports and URL paths are different for Confluence and JIRA. By default, both applications use port 8080. Change
the default Confluence port and path as follows:
Edit the configuration file at {CONFLUENCE_INSTALL}/conf/server.xml.
Change the value of the port attribute in the Connector element to 8090.
<Connector className="org.apache.coyote.tomcat4.CoyoteConnector"
port="8090" minProcessors="5"
maxProcessors="75"
enableLookups="false" redirectPort="8443"
acceptCount="10" debug="0" connectionTimeout="20000"
useURIValidationHack="false" URIEncoding="UTF-8"/>

Change the value of the path attribute in the Context element to /confluence:
<Context path="/confluence" docBase="../confluence" debug="0"
reloadable="false" useHttpOnly="true">

Save the file.
6. Start your Confluence server by running {CONFLUENCE_INSTALL}/bin/startup.sh.

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 3. Set Up Confluence
Now you can run Confluence's Setup Wizard and change some configuration settings.
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1. To access Confluence, go to your web browser and type this address: http://localhost:8090/confluence.
2. The Confluence Setup Wizard will start up, to guide you through the process of setting up your Confluence server and
creating an administration user. Detailed instructions are in the Confluence documentation.
3. Enter your Confluence license into the 'License Key' field. If you do not already have a Confluence license, follow the
prompts on the Setup Wizard screen to generate an evaluation license online.
4. Click 'Production Installation' under 'Choose Installation Type'.
5. The 'Choose a Database Configuration' screen will appear. Connect Confluence to your PostgreSQL database:
In the 'External Database' section, ensure that 'PostgreSQL' is selected and click the 'External Database'
button.
The 'Configure Database' screen will appear. Click the 'Direct JDBC' button in the 'Direct JDBC Connection'
section.
Enter the following information:
Driver Class Name: org.postgresql.Driver – This is the default value.
Database URL: jdbc:postgresql://localhost:5432/confluence – This is the default value.
Username: confuser – This is the user you created in step 1 (above).
Password – Enter the password that you chose in step 1 (above).
Click the 'Next' button. You might need to wait a few minutes while Confluence sets up its database.
6. On the 'Load Content' screen, click the 'Example Site' button to include the demonstration space content into your
Confluence installation:.
7. The 'Setup System Administrator' screen will appear. Enter the following information:
Username: charlie
Password – Enter a password for the administrator account and enter it again in the 'Confirm' field to confirm
it.
Name: Charlie of Atlassian
Email – We recommend that you give your own email address here.
8. Click the 'Next' button.
9. The 'Confluence Setup Successful' screen will appear. Click 'Start using Confluence now'.
10. If the 'What's new in Confluence' popup window appears, select 'Don't show again' and click 'Close'.
11. The home page of the Confluence 'Demonstration Space' will appear.
12. Finally, you need to change your Confluence base URL to the full (website) address at which Confluence is running,
not just 'localhost':
Open the 'Browse' menu at the top of the screen and select 'Confluence Admin'. Confirm your password
when prompted.
The 'Administration Console' screen will appear. Click 'General Configuration' under 'Configuration' in the
left-hand panel.
The 'General Configuration' screen will appear. Click any of the 'Edit' links.
In the 'Server Base Url' field, enter the full website address at which Confluence is running. This address
should not be 'localhost'. For example, if your computer name is 'coopers' then the server base URL should
be: http://coopers:8090/confluence. Alternatively, specify a website address such as
http://www.foobar.com:8090/confluence.
Scroll down to the end of the page and click the 'Save' button.

Screenshot 2 (click to enlarge): Home page of the Confluence demo space

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 4. Hook Confluence up to JIRA for User Management
When you have finished setting up your Atlassian application suite, JIRA will hold all your users and groups and you will have a single
username across all your Atlassian applications. In this step you will configure Confluence to use JIRA for centralised user management. To
do that, you will define the Confluence application in JIRA, and define the JIRA user directory in Confluence.
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1. If JIRA is not already running, start it up from the Windows Start menu, or by running {
JIRA_INSTALL}/bin/start-jira.sh on UNIX.
2. Define the Confluence application to JIRA:
Go to your JIRA URL in your browser. For example, at http://www.foobar.com:8080.
Log in to JIRA with username charlie.
Click 'Administration', then click 'Users' > 'JIRA User Server'.
Click 'Add Application'.
The 'Add Application' screen will appear. Enter the following information:
Application name: confluence
Password – Enter a password that Confluence will use to access JIRA.
IP Addresses – On a new line, add the IP address or addresses of your Confluence server. For
example: 192.168.10.12
Click 'Save'.
3. Set up the JIRA user directory in Confluence:
Go to your Confluence URL in your browser, e.g. http://www.foobar.com:8090/confluence.
If you are not already on the Confluence administration screen, click 'Browse' > 'Confluence Admin'.
Click 'User Directories' under 'Security' in the left-hand panel.
Click 'Add Directory, select type 'Atlassian JIRA' and click 'Next'.
The 'Configure Atlassian JIRA Server' screen will appear. Enter the following information:
Name: Accept the default value, JIRA Server.
Server URL – Enter the web address of your JIRA server. For example:
http://www.foobar.com:8080
Application Name: confluence – This is the application name that you used when you defined
Confluence to JIRA in the steps above.
Application Password – Enter the password that you entered when defining Confluence to JIRA in the
steps above.
JIRA Server Permissions – Select Read/Write.
Leave the other settings at their default values and click the 'Test Settings' button to test the connection.
When you have a working connection, click 'Save'.
The 'User Directories' screen will appear. Now you will move the JIRA user directory to the top of the list of
directories. Click the blue upward arrow in the 'Order' column next to the 'JIRA Server', so that the JIRA
directory moves to the top of the list.
Here is a summary of how the directory order affects the processing:
The order of the directories is the order in which they will be searched for users and groups.
Changes to users and groups will be made only in the first directory where the application has
permission to make changes.
4. Log out of Confluence then log in again, with the same username charlie and Charlie's password in JIRA.
You are now authenticating via JIRA!

Screenshot 3 (click to enlarge): Confluence user directories

Full details are in the Confluence administrator's guide.
Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 5. Get JIRA and Confluence Talking
In this step you will set up the trusted communication channel between your JIRA and Confluence sites, so that you can display JIRA
information on Confluence pages and Confluence information on the JIRA dashboard. This will be a two-way trust relationship: Confluence
will trust JIRA and JIRA will trust Confluence. You will also make your Confluence gadgets available in JIRA.
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1.
2.
3.
4.
5.
6.
7.

8.
9.

10.
11.

12.
13.
14.
15.

16.
17.

Make sure that both JIRA and Confluence are running.
Go to your Confluence URL in your browser, e.g. http://www.foobar.com:8090/confluence.
Select 'Application Links' from the 'Administration' section of the Confluence Administration Console.
The 'Configure Application Links' screen will appear. Click 'Add Application Link'.
The first screen of the 'Add Application Link' wizard will appear. Copy the base URL for your JIRA site (e.g.
http://coopers:8080 or http://www.foobar.com:8080) and paste it into the 'Server URL' field.
Click 'Next'.
The 'Link to JIRA' screen will appear. Enter the following information:
Create a link back to this server – This option is selected by default. Let it remain selected.
Username: charlie – This is the username of the administrator on your JIRA site.
Password – Enter Charlie's password in JIRA.
Reciprocal Link URL – Leave this field at its default value, pointing to your Confluence site.
Click 'Next'.
The 'Set Users and Trust' screen will appear. Enter the following information:
The servers have the same set of users – This option is selected by default. Let it remain selected.
These servers fully trust each other – This option is selected by default. Let it remain selected.
Click 'Create'.
Now you will make your Confluence gadgets available in JIRA, so that JIRA users will be able to add any Confluence
gadget to their dashboards. Go to your JIRA browser window and click 'Exit Administration' to go to the JIRA
dashboard.
Click 'Add Gadget'.
The 'Gadget Directory' popup window will appear. Click 'Gadget Subscriptions'.
The 'Gadget Subscriptions' popup window will appear. Click 'Add Subscription'.
The 'Add Subscriptions' popup window will appear. Copy the base URL for your Confluence site (e.g.
http://coopers:8090/confluence or http://www.foobar.com:8090/confluence) and paste it into the
text box on the screen.
Click 'Add Subscription'.
Click 'Finished'.
The Confluence gadgets are now available in your JIRA gadget directory. You have not yet added them to your
JIRA dashboard. We will do that in a later step.

Screenshot 4 (click to enlarge): Adding JIRA as a trusted application in Confluence

The Confluence documentation has the details about application links and trusted applications.
Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 6. Create a Wiki Space
Now you can create a space in Confluence. A 'space' is a logical collection of pages, comparable to a library. A space is configurable and
managed independently within the wiki site. It is almost like a wiki within a wiki.
The Atlassian Confluence demonstration space was created for you when you set up Confluence above.
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1. Click 'Dashboard' at the top left of the Confluence screen.
2. Click 'Add Space' on the left-hand side of the screen.
3. The 'Create Space' screen will appear. Configure your space settings:
Enter a space name: Dragons
Enter a space key: DRA
Who can use this space? – Leave the default settings as they are.
Choose Theme – Leave the default settings as they are (that is, 'Global Look and Feel').
Click 'OK'.
4. The 'Home' page of your new 'Dragons' space will appear, with some default content. Now you can edit the home page
as you like. For this exercise, you will add a Charlie badge:
Right-click on the image of the Charlie badge at the bottom of this documentation page and save it to your
desktop. The file name is 'dragon_badge03.png'.
Click 'Edit' at the top right of your new Dragons home page in your own Confluence site.
The wiki rich text editor will open. If prompted, allow 'Gears' access to your site. This will allow you to drag
and drop images and other attachments onto your wiki page.
Select and delete all the text in the editor pane. You will start with an empty page.
Make sure your cursor is at the top of the editor pane.
Click the 'Insert Image' icon
in the editor toolbar.
The 'Insert Image' popup window will appear. Browse to your desktop and upload the Charlie badge image
that you saved earlier. Alternatively, you can drag and drop the image from your desktop into the 'Insert
Image' window.
The image will appear in the preview panel of the 'Insert Image' window. Click 'Insert'.
The image will appear in the editor pane of your home page.
Click 'Save' to save your updated wiki page.

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 7. Add Some JIRA Issues to your Confluence Page
Now you can put some interesting JIRA content into your page. What's more, you can insert an issue into JIRA directly from your Confluence
page and then display the issue on the page.
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1.
2.
3.
4.

Edit the Confluence page again.
Place your cursor immediately after your Charlie badge image and press 'Enter' to start a new line.
Enter the following text onto the page: My JIRA issues
Select the text that you have just entered and format it as a heading level 2. (Click the formatting dropdown menu on
the left-hand edge of the editor tool bar. By default it formats your text as 'Paragraph'. Select 'Heading 2'.)
5. Deselect the text and then press 'Enter' to start a new line.
6. Follow the steps below to add a JIRA macro to your page, showing a dynamic list of issues drawn from the ' Dragons'
project on your JIRA site.
Click the 'Insert JIRA Issue' icon
in the editor toolbar.
The 'Insert JIRA Issue' popup window will appear. Click 'Search' in the left-hand panel.
Enter the following JQL (JIRA Query Language) phrase into the search box: project = DRA
Click the 'Search' button.
A list of issues will appear, matching your search query. Select the option to 'Insert all query results as a
table'.
Click 'Insert'.
The JIRA macro will appear on your page. In edit mode it looks like this:
{jira:project = DRA|server=My Company JIRA}

7.
8.
9.
10.
11.

Click the 'Preview' tab to see a preview of the page. You will see a list of the JIRA issues in your 'Dragons' project.
Click the 'Rich Text' tab to return to the editor.
Enter the following text onto the page, and format it as a heading level 2: Reporting a new issue
Start a new line.
Follow the steps below to add a new issue into JIRA and display the issue on your Confluence page:
Click the 'Insert JIRA Issue' icon
in the editor toolbar.
The 'Insert JIRA Issue' popup window will appear. Click 'Create New Issue' in the left-hand panel.
Enter the following information:
Project: Dragons
Issue Type: Bug
Summary: The purple dragon melted my chocolate
Version/s: 2.0.S2
Description: The dragon tried to eat my chocolate and flamed it by mistake.
Click 'Insert'.
You now have a new issue DRA-4 in JIRA. In addition, a new JIRA macro will appear on your Confluence
page, showing only the issue that you have created in JIRA. In edit mode the macro looks like this:
{jira:DRA-4|server=My Company JIRA}

12. Save the page.
Note: The new issue will appear immediately under the heading 'Reporting a new issue'. To see the new issue appear
in the table under 'My JIRA issues', you may need to click the refresh icon
because the issues shown in the table are cached.

at the bottom of the table. This is

Screenshot 5 (click to enlarge): Your updated Dragons home page in Confluence

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 8. Add a Confluence Gadget to JIRA
Now you will add the Confluence 'Activity Stream' gadget to your JIRA Dragon Development Dashboard.
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1. Click 'Dashboards' at top left of your JIRA screen.
2. Your 'Dragon Development Dashboard' will appear. Click 'Add Gadget'.
3. The 'Gadget Directory' will appear, showing a list of the available gadgets for your JIRA dashboard. Enter 'activity' into
the search box at top right of the Gadget directory screen.
4. The list of gadgets will change, to show only the gadgets that match your search term. You will see two 'Activity
Stream' gadgets, once for JIRA and one for Confluence. To find the Confluence one, look at the gadget URL and find
the URL that contains port '8090'.
5. Click 'Add it Now' under the appropriate gadget. The gadget will be highlighted for a short time and the button's
wording will change to 'Adding', while JIRA adds the gadget to the dashboard.
6. Click 'Finished' to go back to your dashboard.
7. Enter the following information to configure the 'Activity Stream' gadget:
Title: Confluence Dragons Activity
Projects: Dragons
Refresh Interval: Every 15 Minutes
Leave the other fields at their default values and click 'Save'.
8. Re-arrange your dashboard:
Drag the 'Projects' gadget to the right and drop it under the 'Assigned to Me' gadget.
Drag the 'Agile Gadget' to the bottom right.
9. Choose a different colour for your 'Activity Stream' gadget:
Move your cursor pointer over the gadget and click the downward-pointing arrow at top right of the gadget
frame.
Select the red square in the row of colours.

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Victory!
Your JIRA dashboard now has 4 gadgets:
The Confluence 'Activity Stream' gadget
The 'Assigned to Me' gadget
The 'Projects' gadget
The GreenHopper 'Agile Gadget'
Screenshot 6 (click to enlarge): JIRA dashboard with 4 gadgets

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Grab your Sword and Move to the Next Stage

Tweet? Tweet.
Go to Dragons Stage 4 - Install FishEye and Crucible.

Dragons Stage 4 - Install FishEye and Crucible
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There will be much flapping of wings and breathing of fire. You are embarking on stage 4 of the Atlassian Dragon Quest.
In this stage, you will install FishEye and hook it up to a Mercurial repository on Bitbucket for breathtaking overviews of your source code
repository. At the same time, you will set up Crucible for piercingly insightful code reviews. Prepare to be blown away by FishEye/Crucible's
integration with JIRA and Bamboo.
Time estimate: This stage will take approximately 30 minutes.
On this page:
Step 1. Install Mercurial
Step 2. Create your FishEye Database in PostgreSQL
Step 3. Install FishEye and Crucible
Step 4. Set Up FishEye and Crucible
Step 5. Connect FishEye to Bitbucket
Victory!

Step 1. Install Mercurial
The first step is to install a source control management tool, so that you have a code repository for FishEye to look at. We will use Mercurial.

1. Get Mercurial and Python. Make sure that you get a Mercurial 1.5 or later.
Note: For some UNIX distributions, the default download will include Mercurial 1.4.3. You will need 1.5 to 1.8.x. To find
the download for a specific version of Mercurial, go to the download directory.
2. Add or edit your Mercurial configuration file at C:\Documents and Settings\MY_NAME\mercurial.ini
(Windows XP) or C:\Users\MY_NAME\mercurial.ini (Windows 7) or ~/.hgrc (UNIX). The file should contain
your preferred editor and your username.
If the Mercurial configuration file does not exist, create it.
If you do not already have a username, you can use atlassian_dragons:
[ui]
; editor used to enter commit logs, etc.
editor = notepad
username = atlassian_dragons

Most text editors will work.

Step 2. Create your FishEye Database in PostgreSQL
Now you will create a database where FishEye will store its data, and the user that FishEye will use to connect to the database. Crucible will
use this database as well. We are assuming that you have already created your PostgreSQL database server in Dragons Stage 1.
We are using pgAdmin III, the administration user interface supplied with PostgreSQL. If you used the one-click installer in Dragons
Stage 1, pgAdmin III will be already installed on your computer.
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1. Start pgAdmin III.
2. Add a new login role called 'fishuser':
Right-click 'Login Roles' and select 'New Login Role'.
Enter the role 'Role name': fishuser.
Enter a suitable 'Password' and enter it again to confirm it.
Click the 'Role privileges' tab.
Select 'Can create database objects'.
Select 'Can create roles'.
Click 'OK' to create the user.
3. Add a new database called 'fisheye':
Right-click 'Databases' and select 'New Database'.
Enter the database 'Name': fisheye.
Select the 'Owner': fishuser.
Click 'OK' to create the database.

Alternatively, If you are on UNIX and do not have pgAdmin III, you can use the command line interface instead. Assuming that you are
using the default installation directory of /opt/PostgreSQL/8.3/bin/, enter the following commands:

sudo -s -H -u postgres
# Create the FishEye user:
/opt/PostgreSQL/8.4/bin/createuser -S -d -r -P -E fishuser
# Create the FishEye database:
/opt/PostgreSQL/8.4/bin/createdb --owner fishuser --encoding utf8 fisheye
exit

Screenshot 1 (click to enlarge): FishEye/Crucible database and user in PostgreSQL

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 3. Install FishEye and Crucible
Requirements: FishEye/Crucible 2.6.2.
For Windows: (click to expand)
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1. Go to the Atlassian download centre.
2. Download the 'FishEye 2.6.2' zip archive. This archive includes Crucible 2.6.2 as well.
Please use the FishEye version specified in this documentation. If the download centre shows a FishEye
version later than 2.6.2, click 'downloads archive' and get FishEye 2.6.2.
Why? We have tested the integration suite with this version. There is a chance that you will have problems
integrating the other applications if you use a different version.
3. Unpack the zip archive into a directory of your choice, avoiding spaces in the directory name. For example:
c:\fisheyecrucible. We will now refer to this location as the FishEye/Crucible installation directory.
4. Now you will create another directory where FishEye/Crucible will store local data, separate from the installation
directory:
Create the new directory, e.g. C:\data\fisheyecrucible.
Create an environment variable called 'FISHEYE_INST' and point it to your new data directory. (Open
your Windows 'Control Panel'. Click 'System' to open the 'System Properties'. Click the 'Advanced' tab.
Click 'Environment Variables'. Add a new 'System variable' with the name 'FISHEYE_INST' and a
value of your new data directory's location, such as C:\data\fisheyecrucible.)
Note: Ignore the fact that this environment variable is called 'INST'. It has nothing to do with the
installation directory. This environment variable points to the data directory, but it must still have the name
specified above.
Copy the config.xml file from the root of your FishEye/Crucible installation directory to the root of your
new data directory.
5. Because FishEye/Crucible will be running on the same machine as JIRA (already installed), you need to ensure
that the URL paths are different for FishEye/Crucible and JIRA. Change the default FishEye/Crucible path as
follows:
Edit the config.xml in your FishEye/Crucible data directory.
Add the context attribute to the web-server element:
<web-server context="/fisheye">

6. Start FishEye/Crucible from the command line by running bin\run.bat from your FishEye/Crucible installation
directory.
Wait a few minutes for the server to launch. This message will appear on the command line once ready:
'INFO - Server started on :8060 (http) (control port on your-server-IP-address:8059)'.

For Linux: (click to expand)

1. Go to the Atlassian download centre.
2. Download the 'FishEye 2.6.2' zip archive. This archive includes Crucible 2.6.2 as well.
Please use the FishEye version specified in this documentation. If the download centre shows a FishEye
version later than 2.6.2, click 'downloads archive' and get FishEye 2.6.2.
Why? We have tested the integration suite with this version. There is a chance that you will have problems
integrating the other applications if you use a different version.
3. Unpack the zip archive into a directory of your choice, avoiding spaces in the directory name. For example:
/opt/fecru-x.x.x. We will now refer to this location as the FishEye/Crucible installation directory.
4. Now you will create another directory where FishEye/Crucible will store local data, separate from the installation
directory:
Create the new data directory, e.g. /opt/fisheyecrucible.
Create an environment variable called 'FISHEYE_INST' and point it to your new data directory.
Note: Ignore the fact that this environment variable is called 'INST'. It has nothing to do with the
installation directory. This environment variable points to the data directory, but it must still have the name
specified above.
Copy the config.xml file from the root of your FishEye installation directory to the root of your new data
directory.
5. Because FishEye/Crucible will be running on the same machine as JIRA (already installed), you need to ensure
that the URL paths are different for FishEye/Crucible and JIRA. Change the default FishEye/Crucible path as
follows:
Edit the config.xml in your FishEye/Crucible data directory.
Add the context attribute to the web-server element:
<web-server context="/fisheye">

6. Start FishEye/Crucible from the command line by running ./bin/run.sh from your FishEye/Crucible installation
directory.
Wait a few minutes for the server to launch. This message will appear on the command line once ready:
'INFO - Server started on :8060 (http) (control port on your-server-IP-address:8059)'.

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.
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Step 4. Set Up FishEye and Crucible
In this step you will do the initial setup of your FishEye/Crucible site. As part of this process, you will connect FishEye and Crucible to JIRA,
so that you can manage all your users via JIRA and share information between JIRA and FishEye/Crucible.

1. To access FishEye/Crucible, go to your web browser and type this address: http://localhost:8060/fisheye.
Alternatively, type the host name or IP address instead of localhost.
2. The FishEye/Crucible setup wizard will start.
If you already have a license key, click 'Enter existing license'. Enter your FishEye license into the 'FishEye
License Key' field and your Crucible license into the 'Crucible License Key' field.
If you do not have a license key, click 'Obtain evaluation license' and follow the instructions on screen. If
prompted, ensure that you choose to include Crucible as part of this evaluation.
3. Click 'Next'. The 'Connect to JIRA' step will appear. Enter the following information:
JIRA Base URL – Enter the web address of your JIRA server. For example:
http://www.foobar.com:8080
Admin Username: charlie
This is Charlie's username in JIRA.
Admin Password – Enter Charlie's password for JIRA.
4. Leave the other fields (the 'advanced options') at their default values and click the 'Connect to JIRA' button.
5. The 'Set administrator password' screen will appear. Enter an administration password and then enter it again to
confirm it.
This is the password you can use to access your FishEye/Crucible administration screens, by clicking the '
Administration' option at the bottom of the FishEye screens. In addition, you will be able to access the administration
screens using the username charlie and Charlie's JIRA password.
6. Click 'Next'.
7. Click 'Add repository' to exit the wizard.
8. Log in to FishEye/Crucible when prompted.
You can use the administration password that you defined in the previous step, or you can use Charlie's login. We
recommend that you log in as Charlie:
a. Click 'Log In' in the top menu bar.
b. Enter the username 'charlie' and Charlie's password in JIRA.
c. Click the dropdown arrow on the right of Charlie's name in the top menu bar, and select 'Administration'.
9. Now you will connect FishEye/Crucible to your database. In the left-hand 'Admin' menu, click 'Database' under
'Systems Settings'.
10. Click 'Edit' and enter the following details:
Type – Select 'PostgreSQL'.
Driver Location – Select 'Bundled'.
URL: jdbc:postgresql://localhost:5432/fisheye – Note that this value is different from the default
value.
User Name: fishuser – This is the user you created in step 2 (above).
Password – Enter the password you defined in step 2 (above).
11. Click 'Test Connection' to verify that FishEye/Crucible can log in to the database.
12. Click 'Save & Migrate', then click 'OK' when the migration is complete.

Screenshot 2 (click to enlarge): FishEye/Crucible database migration successful

Full details are in the FishEye documentation.
Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 5. Connect FishEye to Bitbucket
For this integration exercise we provide a Bitbucket repository that you can connect to your FishEye 'Dragons' repository. Bitbucket is a code
hosting site for the Mercurial distributed version control system (DVCS). We recommend this repository because:
We have committed a code change with a JIRA issue key in the commit message, to match a JIRA issue you created earlier. This
will allow you to see the JIRA and FishEye integration immediately, without having to do your own commit.
The sample repository is small, so that FishEye's initial repository indexing process will be fast.
FishEye supports Mercurial, Subversion and a number of other repository types. When you start using FishEye outside this integration
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exercise, you will need to create another FishEye repository and connect it to your source repository as described in the FishEye
documentation.
For this integration exercise, follow the steps below to connect to our sample repository.

1.
2.
3.
4.

5.

6.

7.
8.
9.
10.
11.

Go to your FishEye administration screen in your browser.
In the left-hand 'Admin' menu, click 'Repositories' under Repository Settings.
Click the 'Add' button. The first screen of the 'New Repository' wizard will appear.
Enter the following information:
Repository Type: Mercurial
Name: Dragons
Description: Dragons repository
Click 'Next' and enter the following information:
Repository Location: https://bitbucket.org/atlassian_dragons/dragonslayers
Authentication Style: No authentication
Click 'Next' and enter the following information:
Store Diff Info – Select this checkbox.
Enable Repository After Adding – Select this checkbox.
Click 'Test Connection' to verify that Bitbucket is properly connected to FishEye. Click 'Close'.
Click 'Add'. The 'Repositories' page will display the 'Dragons' repository.
Click the 'Source' tab at the top of the screen.
Click the star symbol next to the 'Dragons' repository to select it as a favourite.
Click the FishEye logo at top left of the screen to return to the FishEye dashboard. You should be able to see the
activity stream showing recent commit messages for the repository.
If you do not see any activity, please wait a while for FishEye to finish scanning (indexing) the repository. With our
sample repository, this should only take a few minutes.

Screenshot 3 (click to enlarge): FishEye dashboard with activity stream

Full details are in the FishEye documentation. You can learn about Bitbucket and Mercurial in the Bitbucket documentation.
Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Victory!
You can now see your source in FishEye. Go to the FishEye dashboard, click the 'Source' tab and click 'Dragons' to browse the
contents of your new 'Dragons' repository.
If your repository is large, FishEye may take a while to index all your files. If the index scanning is still underway, you will see a message
at the top of the screen saying 'NOTE: The repository is being scanned, some statistics may not be up to date.
...
Want an RSS feed of your repository activity? Go to the 'Activity' tab on the 'Source' view. Click 'Tools' then 'RSS Feed'. You can get an
RSS feed on the dashboard too.
Click the changeset number (0:922fd9308885) in the activity stream to see FishEye's view of your source code.
Screenshot 4 (click to enlarge): FishEye source repository viewer
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Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Grab your Shield and Move to the Next Stage

Tweet? Tweet.
Go to Dragons Stage 5 - Get JIRA and FishEye Talking.

Dragons Stage 5 - Get JIRA and FishEye Talking

You are embarking on stage 5 of the Atlassian Dragon Quest, a place filled with flame and serpents and dragons.
In this stage you will configure JIRA and FishEye, so that you will be able to see code commits in JIRA and see JIRA issues in FishEye.
Time estimate: This stage will take approximately 15 minutes.
On this page:
Step 1. Configure your JIRA Settings in FishEye/Crucible
Step 2. Link your FishEye and JIRA Projects and Subscribe JIRA to FishEye's Gadgets
Step 3. Configure the FishEye Plugin in JIRA
Step 4. Add a FishEye Gadget to JIRA
Victory!

Step 1. Configure your JIRA Settings in FishEye/Crucible
When running the FishEye setup wizard, you connected JIRA to FishEye/Crucible. Now you will update that application link and enable
subtasks for Crucible. This is required for creating JIRA issues from Crucible reviews. You will also enable the remote API in FishEye.
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1.
2.
3.
4.
5.

6.
7.
8.
9.
10.

Go to your FishEye URL in your web browser. For exaample: http://localhost:8060/fisheye
Click the downward-pointing arrow next to your username ('charlie') then click 'Administration' in the dropdown menu.
Click 'Application Links' in the left-hand panel.
The 'Configure Application Links' screen will appear, showing a connection to your JIRA server. Click 'JIRA Settings'
next to the JIRA application link.
The 'Update JIRA Server' screen will appear. Enter the following information:
Select the 'Include in Activity Streams' checkbox.
Click the 'Test' button in the 'Subtask Settings' section. The options 'Subtask Settings' section will change,
allowing you to complete the following fields.
Select the 'Subtask Type': Technical task
Enter the 'Subtask Resolution Action ID': 2
Leave the 'Subtask Resolution' at its default value: Cannot Reproduce
Select 'Allow Unassigned': Yes
Click 'Save'.
Click the 'Server' link in the left-hand menu under 'Global Settings'.
The 'Server Settings' screen will appear. Click 'Edit Settings'.
The 'Edit Web Settings' screen will appear. Select the 'On' radio button next to 'Allow remote API calls'.
Click 'Update'.

Screenshot 1 (click to enlarge): Application link to JIRA in FishEye

Step 2. Link your FishEye and JIRA Projects and Subscribe JIRA to FishEye's Gadgets
In this step you will link your FishEye 'Dragons' repository to your JIRA 'Dragons' project via a project link. This will enable the hyperlink on
JIRA issue keys in FishEye and the summary popup window that appears when you move your cursor over a JIRA issue key. You will also
make your FishEye gadgets available for use in JIRA.

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.

12.
13.

Go to your FishEye URL in your web browser. For example: http://localhost:8060/fisheye
Click the downward-pointing arrow next to your username ('charlie') then click 'Administration' in the dropdown menu.
Click the 'Repositories' link in the left-hand menu under 'Repository Settings'.
The 'Repositories' screen will appear. Click the cog icon next to your 'Dragons' repository and select 'Application
Links' from the dropdown menu.
Click 'Add Link' and select your JIRA server from the dropdown menu.
Click 'Create'. Your FishEye repository is now linked to your JIRA project.
Now you will make your FishEye gadgets available in JIRA, so that users will be able to add any FishEye gadget to
their JIRA dashboard. Go to your JIRA browser window and click 'Dashboards' in JIRA's top navigation bar.
Click 'Add Gadget'.
The 'Gadget Directory' popup window will appear. Click 'Gadget Subscriptions'.
The 'Gadget Subscriptions' popup window will appear. Click 'Add Subscription'.
The 'Add Subscriptions' popup window will appear. Copy the base URL for your FishEye site (for example,
http://coopers:8060/fisheye or http://www.foobar.com:8060/fisheye) and paste it into the text box
on the screen.
Click 'Add Subscription'.
Click 'Finished'.
The FishEye gadgets are now available in your JIRA gadget directory. You have not yet added them to your JIRA
dashboard. We will do that in a later step.

Step 3. Configure the FishEye Plugin in JIRA
The FishEye plugin for JIRA is bundled as part of the JIRA package, so there is no need to install it. Now you will configure the plugin for
your installation and configure JIRA to trust FishEye.
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1.
2.
3.
4.
5.

6.
7.
8.
9.

Go to your JIRA URL in your browser. For example: http://www.foobar.com:8080
Click 'Administration' in the top navigation bar.
The JIRA Administration console will open. Click 'Plugins' > 'FishEye Configuration'.
JIRA's FishEye configuration screen will appear. Click 'Edit Primary Configuration' at the bottom of the screen.
Enter the following information:
Enable Crucible Integration: Yes
Review Search Method: Both
Leave all the other fields at their default values and click 'Update'.
Click 'Application Links Configuration' at the bottom of the screen.
Click 'Trusted Applications' in the 'Outgoing Authentication' column for your FishEye/Crucible link. If prompted, log
in to FishEye as charlie.
Click 'Modify' and enter the following information:
'IP Patterns' – Enter the IP addresses of your FishEye/Crucible site, one address per line. For example:
127.0.0.1
172.20.5.95

Leave the other fields at their default values.
10. Click 'Apply'.
11. Click 'Incoming Authentication' in the left-hand menu.
12. Click 'Modify' on the 'Trusted Applications' tab and enter the following information:
'IP Patterns' – Enter the IP addresses of your JIRA site, one per line. For example:
127.0.0.1
172.20.5.95

'URL Patterns': Enter exactly the following paths, one per line:
/secure/CreateSubTaskIssueDetails.jspa
/browse/
/rest
/plugins/servlet/applinks/whoami
/plugins/servlet/streams
/rpc/soap
/sr/jira.issueviews:searchrequest
/secure/RunPortlet

13. Click 'Apply' and then 'Close'.

Try It Out!
There is now a 'Source' tab on your JIRA issues. Open your DRA-1 issue and click the new 'Source' tab. The tab shows the
changesets related to the issue. These are the changesets where the JIRA issue key was included in the commit message.
Screenshot 2 (click to enlarge): Source tab on a JIRA issue

There is now also a 'Source' tab on your JIRA project. Open your Dragons project to see the new tab. (Click the dropdown arrow
next to 'Projects' in the top navigation bar, then click the 'Dragons (DRA)' project.) The 'Source' tab shows the most recent
changesets related to any issue in the project, provided the changes were committed in the last 30 days.
We committed our changes to the 'Dragons' repository more than 30 days ago, so you will not see any commits on the JIRA
project tab.
You can click through from JIRA to view a changeset or other repository views in FishEye. To try it, go to the 'Source' tab on your
DRA-1 issue and click the changeset number or the repository name ('Dragons').
In FishEye, you can see a popup summary of issue information for an issue key. Try it by moving your cursor over 'DRA-1' in your
FishEye view. You can also click through from FishEye to JIRA by clicking the issue key.
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Screenshot 3 (click to enlarge): Popup summary of JIRA issue in FishEye

Full details are in the JIRA documentation.
Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 4. Add a FishEye Gadget to JIRA
Now you will add the 'FishEye Recent Changesets' gadget to your Dragon Development Dashboard.

1. Click 'Dashboards' at top left of your JIRA screen.
2. Your 'Dragon Development Dashboard' will appear. Click 'Add Gadget'.
3. The 'Gadget Directory' will appear, showing a list of the available gadgets for your JIRA dashboard. Enter 'recent' into
the search box at top right of the Gadget directory screen.
4. The list of gadgets will change, to show only the gadgets that match your search term. Find the 'FishEye Recent
Changesets' gadget and click 'Add it Now'. The gadget will be highlighted for a short time and the button's wording
will change to 'Adding', while JIRA adds the gadget to the dashboard.
5. Click 'Finished' to go back to your dashboard.
6. Configure the 'FishEye Recent Changesets' gadget:
Enter 'Dragons' in the 'Repository' field.
Leave all the other fields at their default values and click 'Save'.
7. Choose a different colour for your 'FishEye Recent Changesets' gadget:
Move your cursor pointer over the gadget and click the downward-pointing arrow at top right of the gadget
frame.
Select the orange square in the row of colours.

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Victory!
Your JIRA dashboard now has 5 gadgets:
The 'FishEye Recent Changesets' gadget
The Confluence 'Activity Stream' gadget
The 'Assigned to Me' gadget
The 'Projects' gadget
The GreenHopper 'Agile' gadget
Screenshot 4 (click to enlarge): JIRA dashboard with 5 gadgets

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.
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Don your Armour and Move to the Next Stage

Tweet? Tweet.
Go to Dragons Stage 6 - Get JIRA and Crucible Talking.

Dragons Stage 6 - Get JIRA and Crucible Talking

You are embarking on stage 6 of the Atlassian Dragon Quest. Be prepared to ride on the dragon's back, for he is swift and strong and will
take you where you need to go.
In this stage you will add a Crucible project and connect it to your JIRA project. Then you will create a review, add a comment to the review
and create a JIRA issue from that review comment. To consolidate your victory, you will add a Crucible gadget to your JIRA dashboard.
Time estimate: This stage will take approximately 15 minutes.
On this page:
Step 1. Create a Crucible Project and Link Your Crucible Project to Your JIRA Project
Step 2. Create a Review
Step 3. Create a JIRA Issue from a Crucible Review
Step 4. Add a Crucible Gadget to JIRA
Victory!

Step 1. Create a Crucible Project and Link Your Crucible Project to Your JIRA Project
In this step you will create a Crucible project and link it to your JIRA project.

1.
2.
3.
4.
5.

6.
7.
8.
9.
10.

Go to your FishEye/Crucible URL in your web browser. For example: http://localhost:8060/fisheye
Click the downward-pointing arrow next to your username ('charlie') then click 'Administration' in the dropdown menu.
Click 'Projects' in the left-hand panel.
The 'Projects' screen will appear. Click 'Create a New Project'.
The 'Edit Project' screen will appear. Enter the following information:
Name: Dragons
Key: DRA
By default, allow anyone to join reviews after creation – Select this checkbox.
Leave all other fields at their default values and click 'Save'.
The 'Projects' screen will appear again, displaying your 'Dragons' project.
Click 'Application Links' in the 'Operations' column next to your 'Dragons' project.
The 'Dragons Application Links' screen will appear. Click 'Add Link' and select your JIRA server in the dropdown
menu.
Click 'Create'.

Screenshot 1 (click to enlarge): Crucible Dragons project linked to JIRA Dragons project

32

Atlassian Integration Guide

Full details are in the Crucible documentation.
Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 2. Create a Review
In this step, you will create a Crucible review from the dashboard activity stream and add a comment in that review.

1. Click the 'Dashboard' tab in FishEye/Crucible.
2. Find changeset '0:922fd9308885', the first changeset in the activity stream. Hover over the line showing that
changeset, click the cog icon next to the date for the commit and click 'Create Review' in the dropdown menu.
3. The 'Edit Review Details' screen will appear. Click 'Start Review'.
4. Click 'Confirm' on the warning screen. The 'DRA-1' review screen will appear.
5. Click 'App.java' under 'src' in the file tree on the left. The code for this file will appear in the right-hand panel.
6. Scroll down to line 11 in the code and click the '11'.
7. A text area will open for you to enter a comment.
Enter the following text in the text area: This comment does not mention dragons. Please amend
the text.
Select the 'Defect' checkbox.
Click 'Post'. The review comment will appear.

You can now see your review in the 'Reviews' tab on your JIRA issue. Go to JIRA and open your DRA-1 issue. Click the 'Reviews' tab.
The tab shows the reviews related to the issue. These are the reviews involving changesets related to the issue.
Screenshot 2 (click to enlarge): Reviews tab on a JIRA issue

Step 3. Create a JIRA Issue from a Crucible Review
Next, create a JIRA subtask from the comment in your Crucible review, and resolve the issue via Crucible.

1. Go to your FishEye/Crucible dashboard.
2. Click 'Re: DRA-1' in the 'Re: DRA-1 commented on review' text in the activity stream.
3. The review details screen will appear. Click 'This comment does not mention dragons' in the 'Latest Comment'
column.
4. The review comment will appear. Click the 'Create Issue' link in the comment panel.
5. The 'Create Issue' panel will appear. Click 'Assign to Me'.
6. Click 'Create'. The key of your new issue (DRA-5) will be displayed in the review comment, with a status of 'Open'.
7. Click the issue key, 'DRA-5'. The issue will open in JIRA.
8. Click your browser's back button to see your review again.
9. Click the 'Resolve' link next to the issue key in your review comment. The status of the issue in the review comment
will change to 'Closed'.
10. Click the issue key, 'DRA-5'. You will see the issue in JIRA with a status of 'Closed'.

Screenshot 3 (click to enlarge): Closed JIRA issue displayed in a review comment
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Step 4. Add a Crucible Gadget to JIRA
Now you will add the 'Crucible Charts' gadget to your Dragon Development Dashboard.

1.
2.
3.
4.
5.

6.
7.

8.

Go to your JIRA URL in your web browser. For example: http://www.foobar.com:8080
Click 'Dashboards' at top left of your JIRA screen.
Your Dragon Development Dashboard will appear. Click 'Add Gadget'.
The 'Gadget Directory' will appear, showing a list of the available gadgets for your JIRA dashboard. Enter 'crucible' into
the search box at top right of the Gadget directory screen.
The list of gadgets will change, to show only the gadgets that match your search term. Find the ' Crucible Charts'
gadget and click 'Add it Now'. The gadget will be highlighted for a short time and the button's wording will change to
'Adding', while JIRA adds the gadget to the dashboard.
Click 'Finished' to go back to your dashboard.
Configure the 'Crucible Charts' gadget:
Enter 'DRA' in the 'Crucible Project Key' field.
Click the dropdown arrow next to 'Refresh Interval' and select 'Every 15 Minutes'.
Click 'Save'.
Choose a different colour for your 'Crucible Charts' gadget:
Move your cursor pointer over the gadget and click the downward-pointing arrow at top right of the gadget
frame.
Select the dark blue square in the row of colours.

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Victory!
Your JIRA dashboard now has 6 gadgets:
The 'Crucible Charts' gadget
The 'FishEye Recent Changesets' gadget
The Confluence 'Activity Stream' gadget
The 'Assigned to Me' gadget
The 'Projects' gadget
The GreenHopper 'Agile' gadget
Screenshot 4 (click to enlarge): JIRA dashboard with 6 gadgets

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.
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Grab a Bigger Sword and Move to the Next Stage

Tweet? Tweet.
Go to Dragons Stage 7 - Install Bamboo.

Dragons Stage 7 - Install Bamboo

You are embarking on stage 7 of the Atlassian Dragon Quest. The dragon may be growing in strength and power, but so are you.
In this stage, you will install Atlassian Bamboo for continuous integration. Then you will get Bamboo talking to JIRA and run your first
Bamboo build.
Time estimate: This stage will take approximately 30 minutes.
On this page:
Step 1. Create your Bamboo Database in PostgreSQL
Step 2. Install Bamboo
Step 3. Set Up Bamboo
Step 4. Hook Bamboo up to JIRA for User Management
Step 5. Get Bamboo and JIRA Talking
Step 6. Set up a Project and Run a Build
Victory!

Step 1. Create your Bamboo Database in PostgreSQL
Now you will create a database where Bamboo will store its data, and the user that Bamboo will use to connect to the database. We are
assuming that you have already created your PostgreSQL database server in Dragons Stage 1.
We are using pgAdmin III, the administration user interface supplied with PostgreSQL. If you used the one-click installer in Dragons
Stage 1, pgAdmin III will be already installed on your computer.
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1. Start pgAdmin III.
2. Add a new login role called 'bamuser':
Right-click 'Login Roles' and select 'New Login Role'.
Enter the role 'Role name': bamuser.
Enter a 'Password' and enter it again to confirm it.
Click the 'Role privileges' tab.
Select 'Can create database objects'.
Select 'Can create roles'.
Click 'OK' to create the user.
3. Add a new database called 'bamboo':
Right-click 'Databases' and select 'New Database'.
Enter the database 'Name': bamboo.
Select the 'Owner': bamuser.
Click 'OK' to create the database.

Alternatively, If you are on UNIX and do not have pgAdmin III, you can use the command line interface instead. Assuming that you are
using the default installation directory of /opt/PostgreSQL/8.3/bin/, enter the following commands:

sudo -s -H -u postgres
# Create the Bamboo user:
/opt/PostgreSQL/8.4/bin/createuser -S -d -r -P -E bamuser
# Create the Bamboo database:
/opt/PostgreSQL/8.4/bin/createdb --owner bamuser --encoding utf8 bamboo
exit

Screenshot 1 (click to enlarge): Bamboo database and user in PostgreSQL

Step 2. Install Bamboo
Requirements: Bamboo 3.2.
For Windows: (click to expand)
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1. Go to the Atlassian download centre.
2. Download the 'Standalone (Windows Installer)' file for Bamboo 3.2.
Please use the Bamboo version specified in this documentation. If the download centre shows a Bamboo
version later than 3.2, click 'downloads archive' and get Bamboo 3.2.
Why? We have tested the integration suite with this version. There is a chance that you will have problems
integrating the other applications if you use a different version.
3. Run the Bamboo Windows installer (atlassian-bamboo-3.2-standalone-windows-x32.exe or
atlassian-bamboo-3.2-standalone-windows-x64.exe).
When prompted, enter the 'folder where you would like Bamboo to be installed'. For example:
C:\Program Files\Bamboo or C:\atlassian\bamboo.
From this point onwards, we will refer to this installation directory as {BAMBOO_INSTALL}.
When prompted, tell Bamboo where to put its 'Bamboo home' directory. For example:
C:\data\bamboo-home.
4. Click 'Finish' to close the setup window when the installer has finished.
5. Because Bamboo will be running on the same machine as JIRA, you need to ensure that the URL paths are
different for Bamboo and JIRA. Change the default Bamboo path as follows:
Edit the wrapper.conf file in your {BAMBOO_INSTALL}\conf folder.
Find the following line:
wrapper.app.parameter.4=/

and replace it with the following line:
wrapper.app.parameter.4=/bamboo

Save the file.
6. Start your Bamboo server by running {BAMBOO_INSTALL\BambooConsole.bat. If you are running Bamboo in
Windows Vista or Windows 7, you may need to run this file in administrative mode by right clicking it and selecting
'Run as administrator'.

For UNIX or Linux: (click to expand)

1. Go to the Atlassian download centre.
2. Click the 'Linux' tab and download the 'Standalone (TAR.GZ Archive)' file for Bamboo 3.2.
Please use the Bamboo version specified in this documentation. If the download centre shows a Bamboo
version later than 3.2, click 'downloads archive' and get Bamboo 3.2.
Why? We have tested the integration suite with this version. There is a chance that you will have problems
integrating the other applications if you use a different version.
3. Unpack the tar.gz archive into a directory of your choice, avoiding spaces in the directory name.
4. Tell Bamboo where to put its Bamboo Home directory:
Edit the properties file at {
BAMBOO_INSTALL}/webapp/WEB-INF/classes/bamboo-init.properties.
Insert the property 'bamboo.home' with an absolute path to your Bamboo Home directory. For example:
bamboo.home=/var/bamboo-home
Save the file.
5. Because Bamboo will be running on the same machine as JIRA, you need to ensure that the URL paths are
different for Bamboo and JIRA. Change the default Bamboo path as follows:
Edit the wrapper.conf file in your {BAMBOO_INSTALL}/conf/ folder.
Find the following line:
wrapper.app.parameter.4=/

and replace it with the following line:
wrapper.app.parameter.4=/bamboo

Save the file.
6. Start your Bamboo server by running {BAMBOO_INSTALL}/bamboo.sh start.

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 3. Set Up Bamboo
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Now you can run Bamboo's Setup Wizard and then check your default Bamboo capabilities.
The instructions below assume that you already have a build tool set up. You can use any of the build tools supported by Bamboo, such as
Maven 1, Maven 2, Ant, PHPUnit and others. Bamboo calls them 'executables'. See the Bamboo documentation. For this integration
exercise, we assume that you are using Maven 2.

1. Set up your Maven 2 environment:
If you do not yet have Maven 2 installed, we recommend that you download and install the Atlassian Plugin
SDK. Note that you do not need to configure an IDE. The SDK includes Maven 2 and a correctly-configured
Maven settings.xml file, as well as a number of shell scripts to speed up and simplify plugin development.
It also includes the Java Activation and other JARs that you will need for a successful Maven build.
If you already have Maven 2, please ensure that you have the required additional JARs. See the FAQ for
information on downloading these JARs.
2. To access Bamboo, go to your web browser and type this address: http://localhost:8085/bamboo.
3. The Bamboo Setup Wizard will start, to guide you through the process of setting up your Bamboo server and creating
an administration user.
Enter your license key. If you do not already have a Bamboo license, follow the prompts on the Setup Wizard
screen to get an evaluation license key.
Choose the 'Custom Installation' setup method.
4. Detailed instructions on the custom installation setup are in the Bamboo documentation. Below are the things you
need to know for our Dragon Quest. Enter the 'General Configuration' information as follows:
Name: Atlassian Bamboo
Base URL – Enter the full website address at which your Bamboo server is running, not just 'localhost'. For
example, if your computer name is 'coopers' then the base URL should be:
http://coopers:8085/bamboo. Or specify a website address, such as
http://www.foobar.com:8085/bamboo.
Configuration Directory – Leave this at the default value.
Build Data Directory – Leave this at the default value.
Build Working Directory – Leave this at the default value.
Artifacts Directory – Leave this at the default value.
Broker URL – Check that the URL contains a full URL and not 'localhost'. If necessary, replace
localhost with the real host name or IP address of your Bamboo server. For example, if your computer
name is 'coopers' then the broker URL should look like this:
tcp://coopers:54663?wireFormat.maxInactivityDuration=300000.
5. Choose External Database for your database configuration and ensure that PostgreSQL 8.2 and above is
selected in the dropdown menu.
6. Enter the following information to connect to the Bamboo database created in step 1 above:
Connection Type: Direct JDBC connection
Driver Class Name: org.postgresql.Driver
Database URL: jdbc:postgresql://localhost:5432/bamboo
User Name: bamuser
Password – Enter the password you specified in step 1 above.
Overwrite existing data – Leave this checkbox unselected.
7. For your 'Starting Data', select 'Create new Bamboo home'.
8. Set up your 'Administrator User Details':
Username: charlie
Password – Enter a password that you will use for the administrator account and enter it again to confirm it.
Full Name: Charlie of Atlassian
Email – Enter the address of your administrator email account. We recommend that you give your own email
address here.
9. Click 'Finish'.
The Bamboo home page will appear.
10. Now you will check that your Bamboo configuration includes your default executable and JDK. Click 'Administration'
in the top navigation bar.
11. The 'Bamboo Administration' screen will appear. Click 'Executables' in the left-hand menu.
12. The 'Executables' screen will appear. Look through the list on the left, to see if your build tool is included along with the
default tools like Script, MSBuild or Bash. For this integration exercise, we assume that you are using Maven 2. In that
case, you should see 'Maven 2' listed in the tabs on the left.
13. If your executable is not included, click 'Add an executable as a server capability' near the top of the page. The 'Add
Capability' panel will appear. Enter the following information:
Capability Type: Executable
Type: Maven 2.x
Executable Label: Maven 2
Path – Enter the path to your Maven installation. This should be the same as the value that you have specified
in your M2_HOME environment variable. For example: C:\maven2.2\apache-maven-2.2.0 (Windows) or
/usr/local/apache-maven/apache-maven-2.2.1 (UNIX).
If you have installed the Atlassian PDK, Maven can be found in a sub-directory under your Atlassian PDK
installation directory. For example, C:\Atlassian\atlassian-plugin-sdk-3.2\apache-maven
(Windows) or /usr/local/Atlassian/atlassian-plugin-sdk-3.2/apache-maven (UNIX).
Click 'Add'.
14. Check that your Bamboo configuration includes your JDK. Click 'JDKs' in the left-hand menu.
15. The 'JDKs' screen will appear. Look through the tabs on the left, to check that your JDK is included. You will need
Oracle JDK 1.6 or higher. Note that the JRE alone is not enough. Stage 1 of these instructions will guide you through
the installation procedure. For this integration exercise, we assume that you are using JDK 1.6. In that case, you
should see a tab on the left 'JDK 1.6.x_xx (JRE)', as well as a 'JDK' and a 'JDK 1.6' tab. Ensure that your Java Home
environment variable is pointing to your JDK directory, not your JRE directory.
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16. If your JDK is not included, click 'add a JDK as a server capability'. The 'Add Capability' panel will appear. Enter the
following information.
Capability Type: JDK.
Label: JDK 1.6.
Java Home – Enter the path to your JDK installation. This should be the same as the value that you have
specified in your JAVA_HOME environment variable. For example: C:\Java\jdk (Windows) or
/opt/java/java_sdk1.6 (UNIX).
Click 'Add'.

Screenshot 2 (click to enlarge): Bamboo home page

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 4. Hook Bamboo up to JIRA for User Management
When you have completed this step, you will be able to manage your Bamboo users in JIRA and have the same usernames and passwords
in JIRA and Bamboo. First you will define the Bamboo application in JIRA. Then you will define the JIRA user directory in Bamboo.

1. Define the Bamboo application to JIRA:
Go to your JIRA URL in your browser. For example, http://www.foobar.com:8080.
Log in to JIRA with username charlie.
Click 'Administration', then click 'Users' > 'JIRA User Server'.
Click 'Add Application'.
The 'Add Application' screen will appear. Enter the following information:
Application Name: bamboo
Password – Enter a password that Bamboo will use to access JIRA.
IP Addresses – On a new line, add the IP address or addresses of your Bamboo server. For example:
192.168.10.12.
Click 'Save'.
2. Set up the JIRA user directory in Bamboo:
Go to your Bamboo URL in your browser. For example, http://www.foobar.com:8085/bamboo.
If you are not already on the Bamboo administration screen, click 'Administration'.
Click 'User Management' under 'Security' in the left-hand panel.
Select 'Users and groups from JIRA or Crowd'.
A panel will open up for the JIRA server details. Enter the following information:
Server URL – Enter the web address of your JIRA server. For example:
http://www.foobar.com:8080
Application Name: bamboo – This is the application name that you used when you defined Bamboo to
JIRA in the steps above.
Application Password – Enter the password that you entered when defining Bamboo to JIRA in the
steps above.
Leave the other settings at their default values and click 'Save'.
3. Log out of Bamboo then log in again, with the same username charlie and Charlie's password in JIRA.
You are now authenticating via JIRA!

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 5. Get Bamboo and JIRA Talking
In this step you will configure an application link between JIRA and Bamboo, so that you can see your build information in JIRA and your
issues in Bamboo.
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1.
2.
3.
4.

5.
6.

7.
8.

9.

Go to your JIRA site in your browser.
Click 'Administration', then click 'Plugins' > 'Application Links'.
The 'Configure Application Links' screen will appear. Click 'Add Application Link'.
The first screen of the 'Add Application Link' wizard will appear. Copy the base URL for your Bamboo site (for example,
http://coopers:8085/bamboo or http://www.foobar.com:8085/bamboo) and paste it into the 'Server URL'
field.
Click 'Next'.
The 'Link to Bamboo' screen will appear. Enter the following information:
Also create a link from 'Atlassian Bamboo' back to this server – This option is selected by default. Let it remain
selected.
Username: charlie. This is the username of the administrator on your Bamboo site.
Password – Enter Charlie's password in JIRA (because you are managing your users in JIRA and are
therefore using Charlie's user profile in JIRA).
Reciprocal Link URL – Leave this field at its default value, pointing to your JIRA site.
Click 'Next'.
The 'Set Users and Trust' screen will appear:
The servers have the same set of users and usernames – This option is selected by default. Let it remain
selected.
These servers fully trust each other – This option is selected by default. Let it remain selected.
Click 'Create'.

Full details are in the JIRA documentation.
Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 6. Set up a Project and Run a Build
In this step you will create a Bamboo project and run a sample build. For the purposes of this integration exercise, we have provided a
Bitbucket repository that you can connect to your Bamboo 'Dragons' plan. We have committed a code change with a JIRA issue key in the
commit message, to match a JIRA issue you created earlier. This will allow you to see the JIRA, FishEye and Bamboo integration
immediately, without having to do your own commit.

1. Click 'Create Plan' in Bamboo's top navigation bar.
2. The 'Create Plan' screen will appear. Click 'Create a New Plan'.
3. The 'Create a New Plan' screen will appear. Enter the following information in the 'Plan Details' section:
Project Name: Dragons
Project Key: DRAG
Plan Name: Main
Plan Key: MAIN
Plan Description: Dragon slaying plan
4. Enter the following information in the 'Source Repository' section:
Source Control: Bitbucket
Username: atlassian_dragons
Password – Not required for our sample repository.
Repository – Select the 'URL' option.
Repository URL: https://bitbucket.org/atlassian_dragons/dragonslayers
5. Leave the rest of the fields in the 'Source Repository' and 'Build Strategy' sections at their default values.
6. Click 'Configure Tasks'.
7. The 'Configure Tasks' screen will appear. Click 'Add Task'.
8. The 'Task Types' screen will appear. Find and select 'Maven 2.x'.
9. The 'Maven 2.x Configuration' panel will appear. Enter the following information:
Task Description: Maven build
Executable: Maven 2
Goal – Change clean test to clean.
Build JDK – Select your JDK version. For example: JDK 1.6.
10. Leave the rest of the fields at their default values and click 'Save'. You have now defined one task in your plan.
11. Select 'Yes please' under 'Enable this Plan'.
12. Click 'Create'.
13. Bamboo will immediately start a build, based on the plan that you have just created. The build may take a few minutes
to complete.
14. The 'Plan Summary' will appear, showing the 'Main' plan in the 'Dragons' project. Click '#1' under 'Recent History' to
open the build result summary for build 'DRAG-MAIN-1'. With any luck, the build should be successful.

Screenshot 3 (click to enlarge): Bamboo build in progress
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Screenshot 4 (click to enlarge): Bamboo build completed

Full details on creating a plan are in the Bamboo documentation.
Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Victory!
Your Bamboo, FishEye and JIRA servers are fully integrated. Here are some of the highlights for you to try.
You can link your builds to JIRA issues in various ways. For example, you can include a JIRA issue key in a commit comment. Details
are in the Bamboo documentation. To see the integration happening right now, add a comment to your build:
Click 'Comment' on the Bamboo build result summary.
Add the following comment: This build is related to DRA-1.
Click 'Add'.
Notice the panel showing the JIRA issue details on the Bamboo build result screen. The issue key is hyperlinked so that you can open
the issue in JIRA.
Screenshot 5 (click to enlarge): Bamboo build result with links to JIRA issue

Click the 'Issues' tab on the build result screen, to see the JIRA issues for a build result.
Screenshot 6 (click to enlarge): Bamboo build result showing a JIRA issues tab

Go to JIRA to see the Bamboo builds that relate to a particular JIRA issue, project or version. Details are in the JIRA documentation
about viewing the Bamboo builds relating to a JIRA issue, project or version. The screenshot below shows the build for a particular issue.
Screenshot 7 (click to enlarge): JIRA issue showing a Bamboo build tab
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When you link your FishEye and Bamboo projects to your own source repository and then commit changes, a source link will appear on
your Bamboo build result. You will be able to click the source link to view the changed code in FishEye. Unfortunately, you cannot reproduce
this now because our sample repository is read-only.
When you release a JIRA version, you can select a Bamboo plan and choose the stages in the plan to run. Releasing the version will run
the plan in Bamboo. If the plan is successful, the version will be released in JIRA. See the JIRA documentation.
Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Grab a Bigger Shield and Go Conquer that Dragon

Tweet? Tweet.
Go to Dragons Stage 8 - Bamboo Gadgets and JIRA Victory.

Dragons Stage 8 - Bamboo Gadgets and JIRA Victory

You're nearly there. Stage 8 is the final step in the Atlassian Dragon Quest. The dragon is a softy!
In this stage you will add the 'Bamboo Plans' and 'Plan Summary' gadgets to your JIRA dashboard. Then you can claim your T-shirt.
Time estimate: This stage will take approximately 5 minutes.
On this page:
Add Two Bamboo Gadgets to JIRA
The Battle is Won, the Dragon is Slain

Add Two Bamboo Gadgets to JIRA
Now you will add the 'Bamboo Plans' and 'Plan Summary' gadgets to your Dragon Development Dashboard in JIRA.
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1. Go to your JIRA dashboard and click 'Add Gadget'.
2. The 'Gadget Directory' popup window will appear. Enter 'bamboo' into the search box at top right of the gadget
directory screen.
3. The list of gadgets will change, to show only the gadgets that match your search term. Find the 'Bamboo Plan
Summary Chart' gadget and click 'Add it Now'. The gadget will be highlighted for a short time and the button's
wording will change to 'Adding', while JIRA adds the gadget to the dashboard.
4. Find the 'Bamboo Plans' gadget and add it too.
5. Click 'Finished' to go back to your dashboard.
6. Configure the 'Bamboo Plans' gadget:
If prompted, click 'Login & approve'.
Log in to Bamboo as 'charlie'.
The 'Request for Access' screen will appear. Click 'Approve Access'. This is how you, as the
Bamboo user, allow your JIRA site to access your Bamboo data.
The 'Bamboo Plans' gadget on your JIRA dashboard will now display some configuration fields.
Uncheck 'Use my favourite plans'.
Start typing 'dragons' in the textbox and select 'Dragons - All Plans' in dropdown menu that opens.
Click the dropdown arrow next to 'Refresh Interval' and select 'Every 15 Minutes'.
Click 'Save'.
7. Configure the 'Bamboo Plan Summary Chart' gadget:
If prompted, click 'Login & approve', then 'Approve Access'.
Click the dropdown arrow next to 'Chart Type' and select 'Duration & Failed Tests (group by Build
Number)'.
Click the dropdown arrow next to 'Refresh Interval' and select 'Every 15 Minutes'.
Click 'Save'.
8. Drag the 'Bamboo Plans' gadget to the bottom right of your dashboard. Drag the 'Bamboo Plan Summary Chart'
gadget to the bottom right too. (This is optional, just to make everything fit into the screenshot you will take later, when
you claim your Atlassian DragonSlayer T-shirt.)
9. Choose a different colour for your 'Bamboo Plans' gadget:
Move your cursor pointer over the gadget and click the downward-pointing arrow at top right of the gadget
frame.
Select the purple square in the row of colours.
10. Colour your 'Bamboo Plan Summary Chart' gadget purple too.

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

The Battle is Won, the Dragon is Slain
Your JIRA dashboard now has 8 gadgets:
The 'Crucible Charts' gadget
The 'FishEye Recent Changesets' gadget
The Confluence 'Activity Stream' gadget
The 'Assigned to Me' gadget
The 'Projects' gadget
The GreenHopper 'Agile Gadget'
The 'Bamboo Plans' gadget
The Bamboo 'Plan Summary' gadget
Screenshot 1 (click to enlarge): JIRA dashboard with 8 gadgets

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.
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Don a T-Shirt. You Rock

Tweet? Tweet.
Order your Atlassian DragonSlayer T-shirt and send us a screenshot of your JIRA dashboard via our website.
See the tips for life after Dragons.

After Dragons

Is there life after Dragons?
Now that you have successfully set up your Atlassian integrated suite, we have some useful information about what you may want to do next.
There's no rush. Get to know the applications and show off your T-shirt for a while first. Then choose any of the points below that may be
relevant to you.
On this page:
Using the Free IDE Connectors
Atlassian Connector for Eclipse
Atlassian Connector for IntelliJ IDEA
Adding Another Atlassian Tool to your Suite
Clover for Code Coverage
Hints after Initial Setup
Adding Users to your Atlassian Integrated Suite
Running Bamboo in a Console Window

Using the Free IDE Connectors
This information is useful to developers who use Eclipse or IntelliJ IDEA. You can work with JIRA issues, Bamboo builds and FishEye links
directly within your IDE (integrated development environment), using the Atlassian IDE Connectors. The connectors are free.

Atlassian Connector for Eclipse
Installation

You can install the connector directly from the Eclipse software updates manager, or via the Mylyn Connector Discovery
wizard, or from a zipped archive. Full instructions are in our installation guide. Here are the instructions for Eclipse 3.5 using
the Mylyn Connector Discovery wizard:
1. Ensure that you have already installed Mylyn 3.2.x. (If you are using an Eclipse package from the
Eclipse download site, Mylyn 3.2 is already included in any package except the Classic download.)
2. In Eclipse Mylyn, open the 'Task Repositories' view. (In Eclipse, click 'Windows', 'Show View', 'Other
' and select the 'Task Repositories' view from the 'Tasks' category.)
3. Click the 'Add Task Repository' icon.
4. The 'Add Task Repository' screen appears. Click the 'Install More Connectors' button.
5. The 'Mylyn Connector Discovery' screen appears. Select the Atlassian Connector and click 'Finish'
to install it.
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Overview

Working with Bamboo builds in Eclipse, you can:
View a list of the builds you are monitoring, in the Bamboo view in Eclipse.
Receive notification of failed builds and other build changes.
Open the Bamboo build details in an Eclipse editor.
Open the Bamboo build details in your web browser, displaying the Bamboo web interface.
Run a build on the Bamboo server.
View a Bamboo build log.
View test results.
View changed files in the build.
Comment on a Bamboo build.
Label a Bamboo build.
Add a new task based on a failed build.

Working with FishEye in Eclipse, you can open a file from Eclipse in FishEye and send your colleagues a FishEye link to your
file.
Working with JIRA issues in Eclipse:
For information on setting up your JIRA server in Eclipse, please read the configuration guide.
Please refer to the JIRA Mylyn documentation for user guidelines.
Videos
and tours

See our website.

Atlassian Connector for IntelliJ IDEA
Installation

You can install the connector from the 'Plugins' menu in IntelliJ IDEA, as described in our installation guide. Here are the
instructions in brief:
1. Open the IDEA plugin manager. (Go to IDEA's 'File' menu and select 'Settings', 'IDE Settings',
'Plugins'.)
2. Right-click 'Atlassian Connector for IntelliJ IDEA' in the 'Available' plugins tab.
3. Select 'Download and Install'.

Overview

Working with Bamboo builds in IDEA, you can:
Receive notifications of failed builds.
View the builds.
Re-run a build.
Open the Bamboo build details in an IDEA output tool window.
View the build history for a selected plan.
View a Bamboo build log.
View failed tests and stack traces.
Click a link in a stack trace to go directly to the code that failed.
Re-run a failed test.
View changed files.
Compare the build version of a file with your local version.
Compare the build version of a file with the previous repository version.
Open the repository version of a file in your IDEA editor.
Comment on a Bamboo build.
Label a Bamboo build.

Working with FishEye in IDEA, you can open a file from Eclipse in FishEye and send your colleagues a FishEye link to
your file.
Working with JIRA issues in IDEA, you can:
View a filtered list of issues.
Make a JIRA issue your active issue.
Make a JIRA issue your active task
Create a new JIRA issue.
Comment on a JIRA issue and view existing comments.
Create a changelist from a JIRA issue.
Log work on a JIRA issue.
View a JIRA issue in an IDEA output tool window.
View stack traces from a JIRA issue and click through to the relevant source file.
View, download and upload attachments on an issue.
Assign an issue to yourself or another user.
Perform workflow actions on a selected issue.
Use the issue quick access options to open an issue in IDEA.
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Videos and
tours

See our website.

Adding Another Atlassian Tool to your Suite
This section tells you about another Atlassian developer tool that you can add to your integrated suite, Clover for code coverage.

Clover for Code Coverage
Clover is a code coverage tool for Java. 'Code coverage' means that Clover measures how much of your Java code is executed by your
tests. Clover has several differentiating features, including the ability to optimise your test execution (make your builds faster), measure
per-test coverage and produce interactive HTML reports. Clover provides plugins for Eclipse and IntelliJ IDEA.
Installation

Clover offers several different installation options, depending on your development and build tools. The details are in the
Clover documentation. Below are the instructions for using Clover within Bamboo. (This configuration will work only for Java
projects using Maven 2 or Ant.) Since you have already installed Bamboo, it is very simple to enable the Clover plugin for
Bamboo. All you need is a license key:
1. Go to your Bamboo URL in your browser, e.g. http://www.foobar.com:8085.
2. Log in to Bamboo with username charlie.
3. Make sure you are on the 'All Plans' tab of the 'Home' screen. (Click 'Home' in the top navigation bar,
then click 'All Plans'.)
4. Click the name of the plan, 'Main', to open the plan summary.
5. Click the 'Configuration' tab.
6. Click the 'Builder' tab.
7. Click the 'Edit Plan' link.
8. Select the checkbox labelled 'Use Clover to collect Code Coverage for this build'.
9. A new section of the screen will open. Select the radio button labelled 'Automatically integrate Clover
into this build'.
10. More reporting options appear. At this stage it is fine to leave them unselected.
11. Optional – Enter your 'Clover License':
If you have a Clover license, enter the license key.
If you do not have a Clover license, leave the license field empty. You can use Clover in
Bamboo for 30 days without obtaining a license.
12. Click 'Save'.
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Overview

Now that you have Clover in Bamboo, you can run a build and see the code coverage. You can also use Bamboo's report
generator to see the Clover Lines of Code report and the Clover Code Coverage report.
If you would like to try it out with our sample repository, follow the instructions below.
Please note: Running the build of our sample project will take quite a long time: approximately 20 minutes. This is
because the build procedure will download and start the Confluence web application so that it can run the integration tests.
1. Click 'Build Actions' near the top right of the Bamboo build plan screen, for your Dragons Main plan.
2. A dropdown menu will appear. Click 'Run Build'.
3. The build will start. If this is the second time you have run a build, it will be called DRAG-MAIN-2. Have
a cup of hot chocolate while the build runs. It will take some time – approximately 20 minutes. Here is a
summary of what it will do:
Download the Clover plugin for Bamboo.
Run the unit tests.
Download the Confluence web application. It does this because our sample project is a
Confluence plugin.
Start a Confluence server in Tomcat on port 1990.
Run the integration tests.
Shut down Confluence.
Collect the Clover artifacts.
Finally, report that the build is successful. (Or that it has failed.)
When the build has finished, click the build name, e.g. DRAG-MAIN-2, near the top right of the
screen.
4. The 'Build Result' screen will appear. Click the 'Clover' tab.
5. The 'Clover Code Coverage' screen will appear.

Screenshot 2 (click to enlarge): Clover in Bamboo

Classic
Clover

More things you can do with Clover:
From within IntelliJ IDEA, view recently-run tests via the Test Run Explorer, see the Java code annotated with
coverage information, view coverage cloud and treemap reports, and optimise your test builds.
From within Eclipse, view recently-run tests via the Test Run Explorer, see the Java code annotated with coverage
information, view coverage cloud and treemap reports, see the unit tests and methods that generated coverage for
the currently opensource file, and optimise your test builds.
Use Clover for Ant, interactively or in automated builds, with a range of current and historical reports, clouds and
charts.
Use Clover for Maven 1 or for Maven 2, view a range of historical and custom reports, and optimise your test builds.

Videos
and tours

See our website.

Hints after Initial Setup
These hints may be useful in the early days after you complete your initial setup. Click the links to see the details of each hint.

Adding Users to your Atlassian Integrated Suite
During the Atlassian Dragon Quest, you added just one user to your integrated suite: Charlie of Atlassian. Very soon you will want to add
more users, and in particular users who are not administrators. You also configured all the Atlassian applications to centralise their user
management in JIRA. We recommend that you use JIRA for all user and group management.

Running Bamboo in a Console Window
If you experience problems with running Bamboo as a Windows service you can start Bamboo in a console window instead, by running {
BAMBOO_INSTALL}\bin\BambooConsole.bat.
RELATED TOPICS
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Here Be Dragons

Adding Users to your Atlassian Integrated Suite
During the Atlassian Dragon Quest, you added just one user to your integrated suite: Charlie of Atlassian. Very soon you will want to add
more users, and in particular users who are not administrators. You also configured all the Atlassian applications to centralise their user
management in JIRA. We recommend that you use JIRA for all user and group management.
Below is a summary of how to add your new users in JIRA. Details are in the JIRA documentation.

1.
2.
3.
4.
5.
6.

Go to JIRA in your browser.
Click 'Administration' in the top navigation bar.
Click 'User Browser' in the left-hand panel.
Click 'Add User'.
Enter the user information and click 'Create'.
Add the new user to the relevant groups, to give the user access to the Atlassian applications:
bamboo-admin
confluence-users
jira-developers
jira-users

RELATED TOPICS

Dragons Stage 1 - Install JIRA
JIRA documentation

Running Bamboo in a Console Window
If you experience problems with running Bamboo as a Windows service you can start Bamboo in a console window instead, by running {
BAMBOO_INSTALL}\bin\BambooConsole.bat.
RELATED TOPICS

Dragons Stage 7 - Install Bamboo

Dragon Slayers with JIRA Already Installed

Beware, all ye who enter, for here be dragons! This is the starting point for the Atlassian Dragon Quest.
By the time you reach the end of this set of instructions, you will have an awesome Atlassian integrated development suite (details here).
There's a good chance that the Atlassian Integration Dragon will scorch the clothes off your back somewhere along the way, so we'll also
send you a free, limited-edition Atlassian DragonSlayer T-shirt if you complete all the steps.
If you do not yet have JIRA installed, please ignore this page and start at Here Be Dragons instead.

Assumptions and Prerequisites
Before you start, please note the points below.
Overall requirements: Check the hardware and software requirements.
JIRA Standalone: You will need the standalone distribution of the latest JIRA release. If you have a WAR distribution, please
consult our support team.
These instructions assume that your JIRA is running on port 8080 (JIRA's default port). If not, please adjust the instructions
accordingly.
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Getting help
If you run into problems at any stage of the integration procedure, please raise a support ticket for the product you're stuck
on. Please don't try to battle on alone. Instead, ask for help immediately. You can also see answers from the community, or
search the forum of past dragon slayers.

Rushing into the Dragon's Lair
Don your armour and alert your serfs
If you like, you can tweet your status.

Follow yon brave dragon slayers
On the Atlassian Dragons Twitter stream.

You're ready to start stage 1. Meet the dragon if you dare! Complete this stage first:
Dragons with JIRA Stage 1 - Set Up Environment and JIRA
Then join the rest of the brave dragon slayers at stage 2:
Dragons Stage 2 - Set Up GreenHopper in JIRA
Dragons Stage 3 - Install Confluence
Dragons Stage 4 - Install FishEye and Crucible
Dragons Stage 5 - Get JIRA and FishEye Talking
Dragons Stage 6 - Get JIRA and Crucible Talking
Dragons Stage 7 - Install Bamboo
Dragons Stage 8 - Bamboo Gadgets and JIRA Victory
After Dragons

Dragons with JIRA Stage 1 - Set Up Environment and JIRA

Beware, all ye who enter, for here there be dragons. You are embarking on stage 1 of the Atlassian Dragon Quest.
In this stage, you will install Java and a database (PostgreSQL) to hold the data for your Atlassian applications. Then you will configure some
JIRA options, and create a project and dashboard for use in the subsequent stages of this integration procedure.
This procedure assumes that you already have JIRA installed. If you do not yet have JIRA, please ignore this page and start at Here
Be Dragons instead.
Time estimate: This stage will take approximately 60 minutes.
On this page:
Step 1. Check your Java Development Kit
Step 2: Install your PostgreSQL Database Server
Step 3. Optional: Create your JIRA Database in PostgreSQL
Step 4. Upgrade JIRA If Necessary
Step 5. Configure JIRA Options
Step 6. Set up a Project and Create your JIRA Dashboard
Victory!
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Step 1. Check your Java Development Kit
Requirements: Oracle JDK 1.6 or higher. Note that the JRE alone is not enough.
If you do not have the right version of the Java Development Kit (JDK) already installed, follow the steps below to get it.

1. Download the Oracle Java SE Development Kit (JDK).
Get the latest version of the JDK 1.6, at least version 6u23 or later.
If you are running 64-bit Windows, please ensure that you use 32-bit JDK and not the 'x64' JDK.
2. Follow the Oracle installation instructions.
3. Make sure you have a JAVA_HOME environment variable pointing to the root directory of the JDK. Some JDK installers
set this automatically.
Check by typing one of the following into a command window, depending on your operating system.
On Windows: echo %JAVA_HOME%
On Linux or UNIX: echo $JAVA_HOME
If the above command does not show you the path to your JDK, please refer to the Crowd instructions on
setting JAVA_HOME.

Step 2: Install your PostgreSQL Database Server
Below are the instructions for installing and setting up a PostgreSQL database server. If your JIRA installation is already using a different
supported database server and you have a good technical knowledge of that server, you can choose to use that database for your other
applications too. However, for the purposes of this integrated setup exercise we do recommend PostgreSQL. Note that you will need the
database server to hold the data for the other Atlassian applications that you will set up in later stages of this integration exercise.
Requirements: PostgreSQL version 8.4.x.

1. Download PostgreSQL – Get the latest 8.4.x. Note that Atlassian does not support PostgreSQL 9.x. For the simplest
installation, choose one of the one-click installers.
2. Install PostgreSQL. If you chose one of the PostgreSQL one-click installers, this is simple: Run the executable that you
downloaded and follow the prompts. Ensure that you choose UTF8 (unicode) encoding when selecting the locale. If
necessary, you can refer to the PostgreSQL installation instructions.
3. Enter a password for the super user ('postgres').
4. Accept the default port 5432.
5. Accept all the other default settings.

Step 3. Optional: Create your JIRA Database in PostgreSQL
Below are the instructions for creating a JIRA database in a PostgreSQL database server.
If your JIRA installation is already using a different supported database server and you have a good technical knowledge of that
server, you can choose to stick with that server and skip this step.
If your JIRA installation is using the default HSQLDB, supplied with JIRA for evaluation purposes, you will need to migrate to another
database before using JIRA in a production environment. Please follow the instructions on migrating your JIRA data to an external
database.
Now you will create a database where the Atlassian JIRA application will store its data, and the user that JIRA will use to connect to the
database. We are assuming that you have already created your PostgreSQL database server in a previous step.
We are using pgAdmin III, the administration user interface supplied with PostgreSQL. If you used the one-click installer when installing
PostgreSQL, pgAdmin III will be already installed on your computer.

1. Start pgAdmin III.
2. Add a new login role called 'jirauser':
Right-click 'Login Roles' and select 'New Login Role'.
Enter the role 'Role name': jirauser.
Enter a 'Password' and enter it again to confirm it.
Click the 'Role privileges' tab.
Select 'Can create database objects'.
Select 'Can create roles'.
Click 'OK' to create the user.
3. Add a new database called 'jira':
Right-click 'Databases' and select 'New Database'.
Enter the database 'Name': jira.
Select the 'Owner': jirauser.
Click 'OK' to create the database.

Alternatively, If you are on UNIX and do not have pgAdmin III, you can use the command line interface instead. Assuming that you are
using the default installation directory of /opt/PostgreSQL/8.4/bin/, enter the following commands:
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sudo -s -H -u postgres
# Create the JIRA user:
/opt/PostgreSQL/8.4/bin/createuser -S -d -r -P -E jirauser
# Create the JIRA database:
/opt/PostgreSQL/8.4/bin/createdb --owner jirauser --encoding utf8 jira
exit

Screenshot 1 (click to enlarge): JIRA database and user in PostgreSQL

Step 4. Upgrade JIRA If Necessary
Requirements: JIRA 4.4.

1. Check your version of JIRA.
2. If you do not have JIRA 4.4 or later, follow the instructions on [upgrading to JIRA 4.4].

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 5. Configure JIRA Options
In this step you will enable some JIRA features that are required for the later stages in this integration procedure.
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1. Log in to JIRA with an administrator account.
2. Create a new administrator account for Charlie of Atlassian:
Click 'Administration' in JIRA's top navigation bar.
Click 'Users' > 'Users', then 'Add User'.
The 'Create New User' screen will appear. Enter the following information:
Username: charlie
Password – Enter a password for the administrator account and enter it again to confirm it.
Full Name: Charlie of Atlassian
Email – We recommend that you give your own email address here.
Send Notification Email – Do not tick this checkbox.
Click 'Create'.
Now you will add Charlie to the 'jira-administrators' group. Click 'Users' > 'Groups'.
Click the 'jira-administrators' group.
Click 'Edit Members'.
Select 'charlie' in the list under 'Join'.
Click 'Join'.
3. Check JIRA's base URL:
Click 'System' > 'General Configuration'.
Change the 'Base URL' if necessary. It must contain the full website address at which JIRA is running, not just
'localhost'. For example, if your computer name is 'coopers' then the base URL should be:
http://coopers:8080. Or specify a website address, such as http://www.foobar.com:8080.
4. Check the following configurations and update them if necessary:
a. Allow unassigned issues and check that the remote API is enabled:
Click 'Administration' in the top navigation bar.
Click 'System' > 'General Configuration' in the top menu.
Enter your password as prompted, to confirm that you want administrator access. (Note that the
Atlassian applications will request this confirmation at various steps in the process. This guide will not
mention this step again.)
Click 'Edit Configuration'.
Select the 'ON' radio button next to 'Allow unassigned issues'.
Check that the 'ON' radio button is selected next to 'Accept remote API calls'. It is on by default.
Click 'Update'.
b. Add the groups that you will need later for Confluence and Bamboo:
Click 'Users' > 'Groups' in the top menu.
In the 'Add Group' section, enter a group name of 'confluence-users' and click 'Add Group".
Add the following two groups as well:
confluence-administrators
bamboo-admin
c. Make Charlie of Atlassian a user and administrator in Confluence and Bamboo by adding him to the relevant
groups:
Click 'Bulk Edit Group Members'.
In the left-hand box, select the three groups:
bamboo-admin
confluence-administrators
confluence-users
In the right-hand box under 'Add members to selected group(s)', enter the username 'charlie'.
Click 'Join'. Charlie's name will appear in the middle box as a group member of the selected groups.

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Step 6. Set up a Project and Create your JIRA Dashboard
In this step you will create some data in JIRA, including a project and an issue, for use in the subsequent stages of this integration procedure.
Then you will create your own JIRA dashboard with a couple of gadgets.
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1. Create a project in JIRA:
Click 'Projects' > 'Projects' in the top menu.
Hint: Try JIRA's quick search instead of the menus. Press g g on your keyboard then start typing 'projects'
into the 'Administration Search' box. If you like, you can use the quick search from this point onwards.
Click 'Add Project'.
Enter the following information:
Name: Dragons.
Key: DRA.
Click 'Add'.
2. Add two versions (1.0 and 2.0):
Click 'Versions' in the left-hand panel of the 'Dragons' project screen.
Enter the following information then click 'Add':
Name: 1.0.
Description: Version 1.0.
Add Version 2.0 as well.
3. Add an issue to your project:
Click 'Exit Administration' at the top of the administration screen
The dashboard will appear. Click 'Create Issue' at the top of the dashboard.
Select the following options then click 'Create':
Project: Dragons.
Issue Type: Bug.
Enter the following information about your new issue then click 'Create':
Summary: Dragon slayer's equipment is defective
Affects Version/s: 1.0.
Assignee: Charlie of Atlassian – Click 'Assign To Me'.
Description: There's a hole in the dragon slayer's water bucket.
Original Estimate: 1d.
You now have an issue with a key of 'DRA-1'.
4. Create a new dashboard for all your dragon-related tasks, issues and general fire fighting:
Click 'Dashboards' at top left of your JIRA screen.
Click 'Tools' > 'Create Dashboard'.
The 'Create New Dashboard' screen will appear. Enter the following information:
Name: Dragon Development Dashboard.
Description: A dashboard for dragon slayers, fire fighters and like-minded
brave souls.
Leave the other fields at their default values and click the 'Add' button at the bottom of the 'Create New
Dashboard' screen (not the one next to 'Add Shares').
5. You now have a new, empty dashboard. Add the 'Projects' gadget to the dashboard:
Click 'Add Gadget'.
The 'Gadget Directory' will appear, showing a list of the available gadgets for your JIRA dashboard. Enter
'projects' into the search box at top right of the gadget directory.
The list of gadgets will change, to show only the gadgets that match your search term. Find the ' Projects'
gadget and click 'Add it Now'. The gadget will be highlighted for a short time and the button's wording will
change to 'Adding', while JIRA adds the gadget to the dashboard.
6. Find and add the 'Assigned To Me' gadget in the same way.
7. Click 'Finished' to go back to your dashboard.
8. Drag the 'Assigned to Me' gadget to the top right of your dashboard:
Move your mouse pointer over the gadget's blue title bar.
The cursor icon will change to a four-pointed arrow
(or a hand). Click the gadget title bar with the left
mouse button then drag the gadget to the right. Drop it in the space labelled 'Drag your gadget here.'
9. Configure the 'Assigned to Me' gadget to point to your 'Dragons' project:
Leave the default values as configured for 'Number of Results' and 'Columns to display'.
Click the dropdown arrow next to 'Refresh Interval' and select 'Every 15 Minutes'.
Click 'Save'.
10. Configure the 'Projects' gadget:
Leave the default values as configured for 'Projects', 'View' and 'Number of Columns'.
Click the dropdown arrow next to 'Refresh Interval' and select 'Every 15 Minutes'.
Click 'Save'.

Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Victory!
You can now see your project dashboard with 2 gadgets on it! The 'Projects' gadget shows the project lead Charlie of Atlassian. The
'Assigned to Me' gadget shows the single DRA-1 issue assigned to Charlie.
Screenshot 3 (click to enlarge): JIRA dashboard with 2 gadgets
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Problems? Please raise a support ticket for the product you're stuck on, see answers from the community, or search the forum of past
dragon slayers.
Victory? Please continue.

Take a Bow and Move to the Next Stage

Tweet? Tweet.
Join the mainstream dragon slayers! Go to Dragons Stage 2 - Install GreenHopper into JIRA.
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